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Changes

Overview

This manual is changed as required to keep it accurate and up-to-date to provide the most 
complete documentation possible for the MagneMotion® Virtual Scope utility. This section 
provides a brief description of each significant change.

NOTE: Distribution of this manual and all addenda and attachments is not controlled. To 
identify the current revision, see the Literature Library on the Rockwell Automation 
website.

Rev. A

Initial release to support MMI_Virtual_Scope version 1.0.0.

Rev. B

Revised to support MMI_Virtual_Scope version 1.0.1.

Updated the following:
• Chapter 5, Troubleshooting.

Ver. 03/C

Revised to support MMI_Virtual_Scope version 1.0.14.

Added the following:
• Added the Back Cover.

Updated the following:
• The revision from alpha (Rev. C) to numeric (Ver. 03).
• Trademark, copyright, and contact information.
• The structure of these changes descriptions.

http://www.rockwellautomation.com/global/literature-library/overview.page
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• In the Appendix, updated the Transport System Limits.
• Updated the Glossary.

Rev. D

Revised to support MMI_Virtual_Scope version 2.0.6.

Added the following:
• In Chapter 1, Introduction, added descriptions of new utilities and new file types to the 

Transport System Software Overview.
• Added Chapter 3, Application Notes, which includes Tuning Motor Performance and 

System Diagnosis. Renumbered all remaining chapters.

Updated the following:
• Updated all trademark, copyright, and support information and moved to the Back 

Cover.
• Updated the part numbers for all referenced manuals.
• Updated the appearance of the safety notices to match Rockwell Automation stan-

dards.
• Updated all UI images to reflect the current version of software.
• In Chapter 1, Introduction, updated the Transport System Components Overview, the 

Transport System Software Overview, and Getting Started with the Virtual Scope Util-
ity.

• In Chapter 2, Using the Virtual Scope Utility, updated the Scope Controls Configura-
tion and the Zoom operation.

• In Chapter 4, UI Reference, updated all descriptions to reflect the new UI.
• In Chapter 5, Troubleshooting, added how to Contact Rockwell Automation Technical 

Support.
• In the Appendix, updated the Transport System Limits.
• Updated the Glossary and the Index.

Removed the following:
• Removed all references to the Mitsubishi PLC TCP/IP Library User Manual as that 

interface is no longer supported.
• Updated the manual to remove references to PLCs and PCs, which are now referred to 

generically as controllers.
• Removed all references to ICT Customer Support> Support now refers to the Rock-

well Automation Technical Support Center and TechConnect℠.
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About This Manual

Overview

This section provides information about the use of this manual, including the manual struc-
ture, related documentation, format conventions, and safety conventions.

Purpose

This manual explains how to install and use the MagneMotion® Virtual Scope utility. This 
utility provides real-time feedback of the change in MagneMotion Linear Synchronous Motor 
performance parameters, which are displayed as waveforms to analyze transport system per-
formance. This manual also provides basic troubleshooting information.

Use this manual in combination with the other manuals and documentation that accompanies 
the transport system to install, configure, test, and operate a MagneMotion transport system.

Audience

This manual is intended for all users of MagneMotion transport systems that are using the Vir-
tual Scope utility to monitor and record the change in LSM performance parameters.

NOTE: Depending on software version, user access privileges, and application configura-
tion, certain operations that are described in this manual may not be available.

Prerequisites

The information and procedures that are provided in this manual assume the following:

• Basic familiarity with general-purpose computers and with the Windows® operating 
system.

• The transport system has already been installed and that full documentation for the 
transport system is available.

• All personnel who configure, operate, or service the transport system are properly 
trained.
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MagneMotion Documentation

The documentation that is provided with the MagneMotion transport system includes this 
manual, which provides complete documentation for the use of the Virtual Scope utility. Other 
manuals in the document set, which are listed in the Related Documentation section, support 
installation, configuration, and operation of the transport system.

The examples in this manual are included solely for illustrative purposes. Because of the 
many variables and requirements that are associated with any LSM system installation, Mag-
neMotion cannot assume responsibility or liability for actual use that is based on these exam-
ples.

Manual Conventions

The following conventions are used throughout this manual:

• Bulleted lists provide information in no specific order, they are not procedural steps.

• Numbered lists provide procedural steps or hierarchical information.

• Keyboard keys and key combinations (pressing multiple keys at a time) are shown 
enclosed in angle brackets. Examples: <F2>, <Enter>, <Ctrl>, <Ctrl-x>.

• Dialog box titles or headers are shown in bold type, capitalized exactly as they appear 
in the software. Example: the Open XML Configuration File dialog box.

• Responses to user actions are shown in italics. Example: Motion on all specified paths 
is enabled.

• Selectable menu choices, option titles, function titles, and area or field titles in dialog 
boxes are shown in bold type and are capitalized exactly as they appear in the soft-
ware. Examples: Add to End…, Paths, Path Details, OK.

• Dialog Box – A window that solicits a user response.

• Click or Left-click – Press and release the left mouse button1.

• Right-click – Press and release the right mouse button.

• Double-click – Press and release the left mouse button twice in quick succession.

• Control-click – Hold down <Ctrl> and press and release the left mouse button.

• Click-and-hold – Press down the left mouse button and hold it down while moving 
the mouse.

• Select – Highlight a menu item with the mouse or the tab or arrow keys.

• Code Samples – Shown in monospaced text. Example: Paths.

1. Mouse usage terms assume typical “right-hand” mouse configuration.
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• Data Entry – There are several conventions for data entry:

• Exact – The text is shown in single quotes. Example: Enter the name “Origin” 
in the text field.

• Variable – The text is shown in italics. Example: Save the file as file_
name.xml.

• Numbers – All numbers are assumed to be decimal unless otherwise noted and use the 
US number format; that is, one thousand = 1000.00. Non-decimal numbers (binary or 
hexadecimal) are explicitly stated.

• Binary – Followed by 2, for example, 1100 0001 01012, 1111 1111 1111 11112.

• Hex – Preceded by 0x, for example, 0xC15, 0xFFFF.

• Measurements – All measurements are SI (International System of Units). The for-
mat for dual dimensions is SI_units [English_units]; for example, 250 mm [9.8 in].

• Part Numbers – All part numbers that are shown are the catalog numbers for ordering 
the item being referenced. These numbers are shown in different formats, for example; 
700-1483-00, MMI-HT-C2198-D032, 2198-KITCON-D032-L.

• Text in blue is a hyperlink. These links are active when viewing the manual as a PDF. 
Select a hyperlink to change the manual view to the page of the item referenced. In 
some cases, the item that is referenced is on the same page, so no change in the view 
occurs.

Notes, Safety Notices, and Symbols

Notes, Safety Notices, and Symbols that are used in this manual have specific meanings and 
formats. Examples of notes, the different types of safety notices and their general meanings, 
and symbols and their meanings are provided in this section. Adhere to all safety notices pro-
vided throughout this manual to help achieve safe installation and use.

Notes

Notes are set apart from other text and provide additional or explanatory information. The text 
for Notes is in standard type as shown in this section.

NOTE: A note provides additional or explanatory information.

Safety Notices

Safety Notices are set apart from other text. The symbol on the left of the notice identifies the 
type of hazard. The text in the message panel identifies the hazard, methods to avoid the haz-
ard, and the consequences of not avoiding the hazard.
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Examples of the standard safety notices that are used in this manual are provided in this sec-
tion. Each example includes a description of the hazard indicated. Labels may also be on or 
inside the equipment to provide specific precautions.

Manual Structure

This manual contains the following chapters:

• Introduction: Provides an overview of the Virtual Scope utility, which is used to moni-
tor and record the change of performance parameters for MagneMotion LSM transport 
systems.

• Using the Virtual Scope Utility: Describes how to use the Virtual Scope utility for per-
formance parameter verification.

• UI Reference: Provides an overview of the Virtual Scope utility user interface and a 
description of each option available through the UI.

• Troubleshooting: Provides identification of errors that may be encountered when using 
the Virtual Scope utility, their meaning, and how to resolve them.

• Appendix: Provides additional information that is related to the Virtual Scope utility 
and MagneMotion transport systems.

• Glossary: A list of terms and definitions that are used in this manual and for the trans-
port system and its components.

• Index: A cross-reference to this manual organized by subject.

NOTE: The version of the Virtual Scope utility that is supplied by MagneMotion may be 
newer than the version that is described in this manual (indicated in Changes on 
page 11). All features that are documented in this manual are supported as indicated. 
Specific builds of the Virtual Scope utility may not implement all features that are 
described in this manual.

NOTICE Identifies an informational notice that indicates practices that
are not related to personal injury that could result in equip-
ment or property damage.

IMPORTANT Identifies information that is critical for the successful appli-
cation and understanding of the product.

ATTENTION: Identifies information about practices or cir-
cumstances that can lead to personal injury or death, property
damage, or economic loss. Attentions help to identify a haz-
ard, avoid a hazard, and recognize the consequence.
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Related Documentation

Before configuring or running the transport system, consult the following documentation:

• MagneMover LITE Configurator User Manual, MMI-UM008.
or
QuickStick Configurator User Manual, MMI-UM009.

• Node Controller Interface User Manual, MMI-UM001.

• NCHost TCP Interface Utility User Manual, MMI-UM010.

• Host Controller TCP/IP Communication Protocol User Manual, MMI-UM003.
or
Host Controller EtherNet/IP Communication Protocol User Manual, MMI-UM004.

• MagneMover LITE User Manual, MMI-UM002.
QuickStick 100 User Manual, MMI-UM006.
or
QuickStick HT User Manual, MMI-UM007.

• Node Controller Hardware User Manual, MMI-UM013.

• LSM Synchronization Option User Manual, MMI-UM005.

• Virtual Scope Utility User Manual, MMI-UM011 (this manual).

NOTE: Distribution of this manual and all addenda and attachments are not controlled. 
Changes to the document set or the software can be made at any time. To identify the 
current revisions or to obtain a current version, see Rockwell Automation Support on 
page 114.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um008_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um010_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um003_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um004_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um002_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um005_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um011_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um009_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um006_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um007_-en-p.pdf


About This Manual

18 MagneMotion
Rockwell Automation Publication MMI-UM011D-EN-P - January 2022

This page intentionally left blank.



Virtual Scope User Manual 19
Rockwell Automation Publication MMI-UM011D-EN-P - January 2022

Introduction 1

Overview

This chapter provides an overview of the Virtual Scope utility that is used analyze transport 
system performance. The Virtual Scope utility displays waveforms to provide real-time feed-
back of the change in MagneMotion® LSM performance parameters. This chapter also pro-
vides a basic overview of the transport system hardware and software. Additionally, the basic 
set of tasks that are required to use the Virtual Scope utility with a MagneMotion transport 
system are described.

Use this manual when analyzing the performance of the transport system using the Virtual 
Scope utility by monitoring the change in LSM performance parameters that are displayed as 
waveforms. Some procedures may vary based on the transport system configuration, commu-
nications, and other variables.

This manual supports:

• MagneMover® LITE motors.

• QuickStick® motors.

NOTE: Make sure that complete design specifications, including the physical layout of the 
transport system, are available before starting to analyze transport system operation.

Included in this chapter are overviews of:

• The Virtual Scope utility.

• The transport system components.

• The transport system software.

• Getting started with the Virtual Scope utility.



Introduction
Virtual Scope Utility Overview

20 MagneMotion
Rockwell Automation Publication MMI-UM011D-EN-P - January 2022

Virtual Scope Utility Overview
The Virtual Scope utility is a Windows® software application that is provided by MagneMo-
tion to provide real-time feedback of the change of LSM performance parameters. All param-
eters are displayed as waveforms to analyze transport system performance.

The transport system is a configuration of linear synchronous motors that are placed 
end-to-end to form long chains or paths. These chains are used to move and position vehicles 
in a controlled manner at various acceleration/deceleration and velocity profiles while carry-
ing a wide range of payloads with high precision. The transport system consists of the follow-
ing components at a minimum:
• MagneMover LITE or QuickStick motors.
• Vehicles with magnet arrays.
• Node controllers.
• Power supplies.
• Configuration file defining paths and nodes.
• User-supplied host controller.

Each of the components of the transport system must be fully defined in the Node Controller 
Configuration File to make sure of proper operation of the transport system. Once the trans-
port system is fully defined, the motor performance can be analyzed using the Virtual Scope 
utility.

NOTE: Additional testing and refinement may be necessary if any aspect of the transport 
system changes, such as vehicle length, payload weight, or other physical factors.

The Virtual Scope utility provides a window with sections for the different functions avail-
able. These functions include the scope display and scope configuration. Some functions open 
dialog boxes for data entry. Using the Virtual Scope to monitor the motion of a vehicle on a 
MagneMotion Linear Synchronous Motor provides:
• Real-time feedback on MagneMotion transport system performance parameters 

(including profile position, velocity, and acceleration) and actual measurements 
(including position, velocity, and acceleration).

• The ability to monitor, measure, and evaluate system settling performance at a station, 
including settling time, move time, settling errors, and overshoot.

• The ability to monitor, measure, and evaluate system performance during moves, 
including tracking errors, real-time position, and velocity.

• The ability to monitor, measure, and evaluate system operating condition parameters, 
including motor current, voltage, and operating temperatures.

The data that is collected using the Virtual Scope can be used for:
• Collecting performance data from MagneMotion transport systems.
• Assisting the PID turning of MagneMotion transport systems.
• Assisting the troubleshooting of MagneMotion transport systems.
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Transport System Components Overview

This section identifies the components of a MagneMotion transport system as shown in Fig-
ure 1-1 and described after the figure.

Figure 1-1: Simplified View of the Transport System using RS-422 Communication

• DC Power Cables and Communication Cables – Distributes DC power to the 
motors and carries communications, such as RS-422 or Ethernet, between the compo-
nents of the transport system.

• High-Level Controller (HLC) – Software application that is enabled on one node 
controller. This application handles all communication with the user-supplied host 
controller and directs communication as appropriate to individual node controllers.

• Host Controller – User-supplied controller for control and monitoring of the Magne-
Motion transport system using either TCP/IP or EtherNet/IP™ communication.

• Motor/Stator – Refers to a MagneMotion linear synchronous motor (LSM).
• Network – Ethernet network providing communication (TCP/IP or EtherNet/IP) 

between the host controller and the HLC (TCP/IP is used between node controllers).
• Node Controller (NC) – Coordinates motor operations and communicates with the 

HLC. Several types of node controllers are available. All node controllers support 
Ethernet communication with the host controller and the motors, and depending on the 
model, provide up to 12 RS-422 ports for communication with the motors. Some node 
controller models also provide digital I/O and/or serial I/O for external devices such as 
switches, E-stops, light stacks, and interlocks.

• Power Supply – Provides DC power to the motors.
• Vehicle with Magnet Array – Carries a payload through the MagneMotion transport 

system as directed. The magnet array is mounted to the vehicle facing the motors and 
interacts with the motors, which move each vehicle independently.

Host Controller

DC Power Cables

Power Supply

Motors

Vehicles

Motor Communication Cables

Node Controller
(and High-Level Controller)

Network
(Ethernet)
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Transport System Software Overview

Several software applications are used to configure, test, and administer a MagneMotion 
transport system as shown in Figure 1-2 and described after the figure. See Related Documen-
tation on page 17 for the reference manuals for these applications.

Figure 1-2: Simplified View of Transport System Software Relationships

Utilities
• NC Web Interface – A web-based software application that is supplied by MagneMo-

tion and resident on the node controllers, for administration of the transport system 
components.

Motors

Host Controller
(EtherNet/IP or TCP/IP)

MagneMotion Configurator

NC Web Interface

NCHost TCP Interface Utility

Node Controller Software Image
(controller_image)

Motor ERF Image Files
(motor_image.erf)

Motor Type Files
(motor_type.xml)

Magnet Array Type Files
(magnet_array_type.xml)

Node Controller Configuration File
(node_configuration.xml)

MagneMotion Info and Config Service
(MICS_motor_data.xml)

Restricted Parameters File
(restricted parameters.xml)

System Control

System Testing(NCHost.exe)

(MMConfigTool.exe)

track_file.mmtrkdemo_script.txt

track_layout.ndx

Virtual Scope Utility

NC Console Interface

(MMI_Virtual_Scope.exe)

(TCP/IP)

(RS-232)

Node Controller

Node Controller
Administration

Performance
Monitoring

Node Controller
Administration

node_configuration.xml

Ethernet Motor Comm Tool
(mmi_commtool.exe)

NC File Retrieval Tool
(NC_File_Retriever.exe)

MICS_motor_data.xml
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• NC Console Interface – A serial communication software application that is supplied 
by MagneMotion and resident on the node controllers, for administration of the node 
controller.

• Virtual Scope Utility – A Windows software application that is supplied by Magne-
Motion to monitor and record the change of motor performance parameters. These 
parameters are displayed as waveforms to analyze the performance of the motors.

• NCHost TCP Interface Utility – A Windows® software application that is supplied 
by MagneMotion to move vehicles for test or demonstration purposes. This applica-
tion supports system testing without the host controller to verify that vehicles move 
correctly before integrating the transport system into a production environment.

• MagneMotion Configurator Utility (Configurator) – A Windows software applica-
tion that is supplied by MagneMotion to create or change the Node Controller Config-
uration File. This utility is available in both MagneMover LITE and QuickStick 
versions. The MM LITE™ version is also used to create or change the Track File and 
Track Layout File for MagneMover LITE transport systems.

• Ethernet Motor Commissioning Tool – A Windows software application that is sup-
plied by MagneMotion to create and edit MagneMotion Information and Configura-
tion Service (MICS) files.

• NC File Retrieval Tool – A Windows software application that is supplied by Magne-
Motion to download configuration and operation files from the specified HLC and all 
node controllers in the transport system.

File Types
• Node Controller Software Image File (IMG file) – The software file for the node 

controllers (controller_image), includes the node controller and HLC applications. 
The Node Controller Software Image file is uploaded to all node controllers in the 
transport system.

• Motor ERF Image Files (ERF file) – The software files for the MagneMotion motors 
(motor_image.erf). The Motor ERF Image files are uploaded to all node controllers in 
the transport system and then programmed into all motors.

• Motor Type Files – XML files (motor_type.xml) that contain basic information about 
the specific MagneMotion motor types being used. The Motor Type files are uploaded 
to all node controllers in the transport system.

• Magnet Array Type File – An XML file (magnet_array_type.xml) that contains 
basic information about the specific MagneMotion magnet array type that is used on 
the vehicles in the transport system. The Magnet Array Type file is uploaded to all 
node controllers in the transport system.

• Node Controller Configuration Files (Configuration file) – An XML file (node_con-
figuration.xml) that contains all parameters for the components in the transport sys-
tem. Multiple Node Controller Configuration Files can be uploaded to all node 
controllers in the transport system, but only one is active.
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• MagneMotion Information and Configuration Service (MICS) File – An XML file 
(MICS_motor_data.xml) that contains the network topology parameters for the trans-
port system when using Ethernet communication with the motors. The file includes the 
MAC address of each motor and the location of each motor on a path. The MICS file is 
uploaded to all node controllers in the transport system.

• Restricted Parameters File – An XML file (restricted_parameters.xml) that provides 
access to restricted configuration elements for specific transport systems. The 
Restricted Parameters file is uploaded to the HLC. For the development of a custom 
Restricted Parameters file for a specific transport system, see Rockwell Automation 
Support on page 114.

• Demo Script – A text file (demo_script.txt) uploaded to the NCHost TCP Interface 
Utility to move vehicles on the transport system for test or demonstration purposes.

• Track File – A text file (track_file.mmtrk) that contains graphical path and motor 
information about the transport system. The Track file is used by the NCHost TCP 
Interface Utility to provide a graphical representation of the transport system to moni-
tor system operation. The Track file is created for MagneMover LITE transport sys-
tems using the MagneMover LITE Configurator. See Rockwell Automation Support on 
page 114 for questions regarding the development of Track files for QuickStick trans-
port systems.

• Track Layout File – An XML file (track_layout.ndx) that contains the parameters for 
the graphical representation of a MagneMover LITE transport system. The Track Lay-
out file is used by the MagneMover LITE Configurator to generate the Node Control-
ler Configuration File and the Track file for MagneMover LITE systems.

• Scope Config File – An XML file (scope_config.xml) that contains basic information 
about the configuration of the Virtual Scope (for example, update period and limits, 
trigger definition, and channel settings).

• Data Stream Config File – An XML file (data_stream_config.xml) that contains 
basic information about the configuration of the data stream that is displayed by the 
Virtual Scope. This configuration includes the motor type, vehicle ID, path ID, motor 
ID, and the parameters to monitor. The name of the file identifies the type of motor 
and the data set.

• Screen Data Files – XML and text files (screen_data.vsdata and screen_data.csv) that 
contain the data points for each of the eight channels for the period of the display. All 
data points are included, even if they are not being displayed. The screen_data.vsdata 
file is used by the Virtual Scope and the screen_data.csv file is used by other applica-
tions such as Excel.

• Data Capture File – A text file (data_capture.csv) that contains the data points for 
each of the eight channels as a running log, even if they are not being displayed. 
Applications such as Excel can use the data_capture.csv file.

NOTICE Modifications to the Image or Type files could cause
improper operation of the transport system.
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Getting Started with the Virtual Scope Utility

Use this manual as a guide and reference when performing tasks with the Virtual Scope utility. 
Follow the steps in this section to get the entire transport system operational quickly with the 
aid of the other MagneMotion manuals (see Related Documentation on page 17).

NOTE: Make sure that all components and complete design specifications, including the 
physical layout of the transport system, are available before starting to test transport 
system operation.

Transport System Quick Start Reference

1. Download the software for the appropriate MagneMotion transport system and the 
MagneMotion Utilities from rok.auto/pcdc.

2. Contact your Motion Solution Consultant for the Virtual Scope installer.

NOTE: The minimum requirements for running the MagneMotion Virtual Scope 
utility are a 64-bit general-purpose computer running Microsoft® Windows 7 
SP1 or Windows 10, with MathWorks® MATLAB® Compiler™ Runtime 
9.10. An Ethernet port (web interface) and an optional RS-232 port (console 
interface) are required to connect to the node controllers.

The user must have read/write permission to the folder where the Virtual 
Scope utility is installed (C:\Users\user_name\AppData\Roaming\Mag-
nemotion Inc\MMI_Virtual_Scope\).

3. Install the components of the MagneMotion transport system as described in the Node 
Controller Hardware User Manual, MMI-UM013, and either the MagneMover LITE 
User Manual, MMI-UM002, the QuickStick 100 User Manual, MMI-UM006, or the 
QuickStick HT User Manual, MMI-UM007.

4. Install the MagneMotion Configurator on a computer for user access (see either the 
MagneMover LITE Configurator User Manual, MMI-UM008, or the QuickStick Con-
figurator User Manual, MMI-UM009).

A. For MM LITE™ systems, define the motors and paths and their relationships in 
the transport system graphically to create the Track Layout File (track_lay-
out.ndx) and the Track File (track_file.mmtrk).

B. For all transport systems, create the Node Controller Configuration File (node_
configuration.xml) to define the components and operating parameters of the 
transport system.

5. Set the IP address for each node controller and specify the node controller to be used 
as the high-level controller (see the Node Controller Interface User Manual, 
MMI-UM001).

https://rok.auto/pcdc
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um002_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um006_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um007_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um008_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um009_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um001_-en-p.pdf
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6. Upload the configuration, image, and type files to each node controller using the node 
controller web interface (see the Node Controller Interface User Manual, 
MMI-UM001).

7. When using motors with Ethernet communication, create the MICS file and provision 
the motors (see either the MagneMover LITE User Manual, MMI-UM002, or the 
QuickStick HT User Manual, MMI-UM007, and the Node Controller Interface User 
Manual, MMI-UM001).

8. Program the motors using the Motor ERF Image files (see the Node Controller Inter-
face User Manual, MMI-UM001, and the NCHost TCP Interface Utility User Manual, 
MMI-UM010).

9. Test and debug the transport system by using the NCHost TCP Interface Utility and 
Demo Scripts (see the NCHost TCP Interface Utility User Manual, MMI-UM010). 
NCHost provides an easy method to verify proper operation and make adjustments 
such as refining the control loop tuning.

NOTE: The NCHost TCP Interface Utility is for test and verification trials only. The 
host controller must be used to control the transport system after verification 
of functionality.

10. Configure the host controller for transport system control as required to meet the mate-
rial movement needs of the facility where the system is installed. When using TCP/IP 
communication, see the Host Controller TCP/IP Communication Protocol User Man-
ual, MMI-UM003. When using EtherNet/IP communication, see the Host Controller 
EtherNet/IP Communication Protocol User Manual, MMI-UM004.

Monitoring the Transport System

Monitor transport system operation using the host controller or the NCHost TCP Interface 
Utility to move a vehicle on a specified motor or motors while observing the motor perfor-
mance parameters displayed on the Virtual Scope.

1. Run the Virtual Scope Utility on page 32.

2. Connect to the Transport System on page 35.

3. Configure the Virtual Scope on page 40.

4. View Data on page 46.

5. Save and Review Data on page 50.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um002_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um007_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um010_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um010_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um003_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um004_-en-p.pdf
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Using the Virtual Scope Utility 2

Overview

This chapter describes how to use the Virtual Scope utility to monitor and record the change 
of LSM performance parameters that are displayed as waveforms. This information is used to 
analyze the performance of the transport system.

Included in this chapter are instructions for:

• Installing the Virtual Scope utility.

• Running the Virtual Scope utility.

• Connecting to the transport system.

• Configure the Virtual Scope.

• View Data.

• Save and Review Data.
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Using the Virtual Scope Utility

These steps provide an overview to get started quickly with the Virtual Scope utility.

1. Install the Virtual Scope software (see Install the Virtual Scope Utility on page 29).

2. Configure the scope for either Single Motor Mode or Multiple Motor Mode from the 
Advanced menu (see Single Motor Monitoring on page 35).

3. Load the appropriate Data Stream file from the Advanced menu (see Load Data 
Stream Configuration on page 40) if needed.

4. Select Setup and configure the scope for the high-level controller (HLC), vehicle, 
path, and motor in the dialog box (see Connect to the Transport System on page 35).

• If using Multiple Motor Mode, load the Node Controller Configuration File for 
the transport system (see Multiple Motor Monitoring on page 37).

5. Configure a Data Capture Log file from the Tools menu to log all data being displayed 
to a file (data_capture.csv) (see Save Virtual Scope Data to a Log File on page 51).

• Select Record to append all Virtual Scope data to the currently defined data 
capture log file and enter any descriptive notes that are related to the data being 
captured.

• Select Stop REC to stop capturing data to the log file.

6. Adjust the horizontal display update period (see Horizontal Controls on page 43).

7. Adjust the horizontal display lower and upper limits (see Horizontal Controls on 
page 43).

8. Select Run to start data collection and display the data.

9. Define the data to be displayed on the scope (see Channel Controls on page 42).

10. Select a channel and configure a trigger (see Trigger Control on page 44).

11. Adjust the vertical display limits for each channel as needed (see Vertical Controls on 
page 45).

12. Select Stop to stop data collection and hold the data display.

13. Print or save the trace data for later analysis (see Save Screen Capture of the Virtual 
Scope Utility on page 50 and Save Current Virtual Scope Data on page 51).
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Install the Virtual Scope Utility

The MagneMotion® Virtual Scope utility must be installed before use. During the installation 
process, the computer is checked to make sure that all required software components are 
installed on the computer. The minimum software requirements for installing and running the 
Virtual Scope utility are:

• Microsoft® Windows® 7 SP1 or Windows® 10.

• MathWorks® MATLAB® Compiler™ Runtime 2021a (9.10).

1. Using a PC, access the folder where the MagneMotion software files were copied and 
run Virtual_Scope_APP_Installer_v2.0.0_Standard_win10. The security settings on 
the computer may require adjustment to allow this installation.

NOTE: The user must have administrator rights when installing the Virtual Scope.

The user must have read/write permission to the folder where the Virtual 
Scope utility is installed (C:\Users\user_name\AppData\Roaming\Mag-
nemotion Inc\MMI_Virtual_Scope\).

The MagneMotion Virtual Scope utility setup wizard is opened as shown in Fig-
ure 2-1.

Figure 2-1: MagneMotion Virtual Scope Utility Installer

2. Select Connection Settings to configure a proxy server if necessary (this is not nor-
mal) and enter the server information.

3. Select Next.

The MagneMotion Virtual Scope utility setup wizard prompts for an installation loca-
tion as shown in Figure 2-2.
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Figure 2-2: MagneMotion Virtual Scope Utility Installation Setup

4. Accept the default installation folder, or specify a folder where the utility will have 
write permission, select Add a shortcut to the desktop if desired, then select Next.
If the correct version of the MATLAB Runtime Compiler is not installed on the com-
puter where the Virtual Scope is being installed, the alert that is shown in Figure 2-3 is 
displayed.

Figure 2-3: MATLAB Runtime Compiler Alert

A. If the MATLAB Runtime Compiler alert is displayed, accept the default instal-
lation folder and select Next.
The MathWorks License Agreement is displayed.

B. Accept the license agreement and select Next.
The installer prepares to download the MATLAB Runtime Compiler and identifies the 
components of the installation as shown in Figure 2-4.
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Figure 2-4: MATLAB Runtime Compiler Download

5. Select Install.

The installer shows the download and installation progress. Once the installation is 
complete, the installer places an Icon on the desktop for access if Add a shortcut to 
the desktop was selected.
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Run the Virtual Scope Utility

This section describes how to start and stop the Virtual Scope utility to analyze operation of a 
MagneMotion transport system using basic vehicle movements.

1. Select the MagneMotion Virtual Scope utility icon, which is shown in Figure 2-5, on 
the desktop or start the program from the Windows Start menu; select MMI_Virtual_
Scope_APP_2021a.

Figure 2-5: MagneMotion Virtual Scope Utility Icon

The Virtual Scope splash screen is displayed as shown in Figure 2-6.

Figure 2-6: Virtual Scope Splash Screen

Depending on the computer running the Virtual Scope, it can take several minutes 
from the time the splash screen is displayed to when the Virtual Scope utility window 
opens. The startup status is displayed as shown in Figure 2-7.

Figure 2-7: Virtual Scope Startup Status

Once startup completes, the Virtual Scope utility window is opened as shown in Fig-
ure 2-8.
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Figure 2-8: The Virtual Scope Utility Window

2. See Connect to the Transport System on page 35 to connect to the transport system and 
enable all functions to begin testing.

Stop the Virtual Scope Utility

1. Make sure that data collection has completed or has been stopped.

2. Disconnect from the HLC by selecting Stop in the Run Controls section of the Scope 
Controls pane.

3. Stop the Virtual Scope utility.

• Select Exit from the File menu or by selecting the X in the upper-right corner 
to close the window.

NOTE: If the Virtual Scope utility is collecting data when Exit is selected, a 
warning message (shown in Figure 2-9) is displayed notifying the 
user that the data collection must be stopped before exiting.

Figure 2-9: Exit Warning

Scope Display Scope Controls
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• Select Quit from the File menu.

NOTE: If the Virtual Scope utility is collecting data when Quit is selected, all 
collected data is discarded.

The Virtual Scope utility window is closed.
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Connect to the Transport System

This section describes how to connect the Virtual Scope utility to the transport system to mon-
itor the change of performance parameters during motor operation. Both the HLC and the PC 
running the Virtual Scope utility must be on the same network.

Single Motor Monitoring

The Virtual Scope session provides a connection to the HLC to monitor and record operation 
of one motor through the Virtual Scope utility. A Node Controller Configuration File is not 
required to identify the path and the motor.

1. To monitor single motor operation, make sure that Single Motor Mode is selected 
(checked) on the Advanced menu.

2. Select Setup from the Run Controls section in the Scope Controls.

NOTE: The scope can only be configured when it is not collecting data.

The Setup Scope Data Collection dialog box for one motor opens as shown in Fig-
ure 2-10.

Figure 2-10: Setup Scope Data Collection Dialog Box, Single Motor Mode

3. Enter the IP address of the high-level controller in the HLC IP text field.

4. Enter the ID of the vehicle, path, and motor to be monitored in the appropriate text 
fields.

5. Select OK to save the configuration.

IMPORTANT Only the motor activity that is related to the specified
motor and vehicle is displayed on the Virtual Scope.
If other vehicles are on the motor, any activity that is
related to them is not displayed. If the specified vehi-
cle is on another motor, any activity that is related to
that motor is not displayed.
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6. Select RUN in the Run Controls to begin monitoring the operation of the motor.

NOTE: Only one Virtual Scope session can be connected to an HLC at a time. Con-
necting a second Virtual Scope session causes the first Virtual Scope session 
to be disconnected and a warning message to be displayed in the Information 
Panel of the first Virtual Scope session.

If a connection is made to the motor specified, the Status Indicator turns green and all 
functions of the Virtual Scope utility are enabled. The status of each active channel is 
shown as a waveform on the Scope Display.

If a connection is made to the motor specified but no data is received (vehicle is not on 
the motor), a diagnostic message that describes the error is displayed in the Informa-
tion Panel above the Run Controls section as shown in Figure 2-11.

Figure 2-11: Connection Error, No Data

If no connection is made to the HLC specified, a diagnostic message that describes the 
error is displayed in the Information Panel above the Run Controls section as shown 
in Figure 2-12.

Figure 2-12: Connection Error, No Connection

7. Use the other functions, as described in this chapter, to use the Virtual Scope.

8. Select STOP in the Run Controls to stop monitoring the operation of the motor and 
hold the data of the current display.
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Multiple Motor Monitoring

The Virtual Scope session provides a connection to the HLC to monitor and record the opera-
tion of multiple motors through the Virtual Scope utility. The Node Controller Configuration 
File for the transport system is used to identify the paths and the motors on those paths. Single 
motors can be monitored if desired.
1. To monitor operation on multiple motors, make sure that Single Motor Mode is 

cleared (unchecked) on the Advanced menu.
2. Select Setup from the Run Controls section in the Scope Controls.

NOTE: The scope can only be configured when it is not collecting data.
The Setup Scope Data Collection dialog box for multiple motors opens as shown in 
Figure 2-13.

Figure 2-13: Setup Scope Data Collection Dialog Box, Multiple Motor Mode

3. Enter the IP address of the high-level controller in the HLC IP text field.
4. If the current Node Controller Configuration File is not easily accessible, download it 

from the node controller.
A. Select Web.

The default browser for the computer is opened with a connection to the node 
controller specified in HLC IP.

B. Log into the node controller using the Web Interface.
The node controller Web Interface opens with the General Status page dis-
played.

C. Select Configuration Files on the Main Menu.
The Configuration Files page is displayed.
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D. Under Node Controller Configuration File, select Download.

The file is downloaded as determined by the browser. The options for saving 
this file vary by web browser.

E. Log out of the node controller Web Interface and close the browser window.

5. Select Load Config File from Disk.

The Select Configuration dialog box is displayed.

6. Use the dialog box controls to select the Node Controller Configuration File for the 
HLC downloaded in Step 4.

The Path Information for the path that is specified in the Path Select text field is dis-
played.

7. Enter the ID of the vehicle and path to be monitored in the appropriate text fields.

8. Enter the IDs of the motors to be monitored in the Motor Select text field separated by 
spaces. Entering “0” selects all motors on the path that is specified in Path Select.

9. Select OK to save the configuration.

10. Select RUN in the Run Controls to begin monitoring the operation of the motors.

NOTE: Only one Virtual Scope session can be connected to an HLC at a time. Con-
necting a second Virtual Scope session causes the first Virtual Scope session 
to be disconnected and a warning message is displayed in the Information 
Panel of the first Virtual Scope session.

If a connection is made to the motors specified, the Status Indicator turns green and 
all functions of the Virtual Scope utility are enabled. The status of each active channel 
is shown as a waveform on the Scope Display.

If a connection is made to the motors specified but no data is received (vehicle is not 
on the motor), a diagnostic message that describes the error is displayed in the Infor-
mation Panel above the Run Controls section as shown in Figure 2-14.

IMPORTANT Only the motor activity that is related to the specified
motors and vehicle is displayed on the Virtual Scope.
If there are other vehicles on the motors, any activity
that is related to them is not displayed. If the speci-
fied vehicle is on another motor, any activity that is
related to that motor is not displayed.
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Figure 2-14: Connection Error, No Data

If no connection is made to the HLC specified, a diagnostic message that describes the 
error is displayed in the Information Panel above the Run Controls section as shown 
in Figure 2-15.

Figure 2-15: Connection Error, No Connection

11. Use the other functions, as described in this chapter, to use the Virtual Scope.

12. Select STOP in the Run Controls to stop monitoring the operation of the motors and 
hold the data of the current display.
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Configure the Virtual Scope

This section describes how to configure the Virtual Scope for operation.

Change Scope Configuration

To change the basic configuration parameters of the Virtual Scope, including the Horizontal 
control settings, the Trigger settings, the Vertical control settings, and Channel selection set-
tings, another scope_config.xml file can be loaded. This file is automatically loaded each time 
that the scope is started and saved each time that the scope is shut down. This automatic sav-
ing of the configuration file preserves any configuration changes (for example, update period 
and limits, trigger definition, and channel settings).

NOTE: Any scope configuration changes made while the scope is running are saved to the 
Scope_Config.xml file in the folder where the Virtual Scope is installed when the 
scope is shut down.
Directly modifying the configuration file could cause improper operation of the 
scope.

1. Select Load from the File menu.
The Select configuration file dialog box is displayed.

2. Use the dialog box controls to select a new scope_config.xml file and select Open.
The new configuration is loaded and the Information Panel is updated to show the 
new configuration.

NOTE: The file can have any name, but it is automatically renamed Scope_Con-
fig.xml when it is uploaded.

Load Data Stream Configuration

To change the Data Stream configuration to monitor different types of data, or to specify 
another motor type another data_stream_config.xml file can be loaded. This file is automati-
cally loaded each time that the scope is started and saved each time that the scope is shut 
down. This automatic saving of the data stream configuration file preserves any configuration 
changes (for example, HLC IP address, vehicle ID, path ID, motor ID). See Table A-1, Data 
Stream Configuration File Data Set Identification, on page 97 for descriptions of the standard 
Data Stream files.

NOTE: Any configuration changes made while the scope is running are saved to the Data_
Stream_Config.xml file in the folder where the Virtual Scope is installed when the 
scope is shut down.
Directly modifying the configuration file could cause improper operation of the 
scope.
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1. Select Load Data Stream… from the Advanced menu.

NOTE: The Data Stream file can only be loaded when the scope is not collecting 
data.

The Data Stream Configuration dialog box is displayed.

2. Select Load Stream Configuration from Disk.

The Select Stream Configuration File dialog box is displayed.

3. Use the dialog box controls to select a new Data_Stream_Config.xml file and select 
Open.

The new Data Stream Information is displayed in the Data Stream Configuration 
dialog box.

NOTE: The file can have any name, but it is automatically renamed Data_Stream_
Config.xml after it is uploaded when the Virtual Scope is shut down.

4. Select OK to accept the changes and close the dialog box, or Cancel to cancel the 
changes and close the dialog box.

If OK was selected, the Information Panel is updated to show the new Data Stream. 
The Signal Information at the top of the scope display (see Figure 4-15 on page 78) is 
updated to show the new signal configuration.
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Scope Controls Configuration

All controls for the scope are displayed in the Scope Controls pane (see Figure 4-7 on 
page 71). See the following sections for detailed operation:

• Channel Controls

• Horizontal Controls

• Trigger Control

• Vertical Controls

Channel Controls

Select the channels and reference lines to be displayed on the scope. Data is collected for all 
channels even if they are not being displayed. Use the Vertical Controls to adjust the display 
of any signals that are off the display.

Figure 2-16: Channel Controls

• Select (check) the desired channel or reference line in the Channel controls at the top 
of the scope display to show that signal.
The Signal Information at the top of the scope display is updated to show the channel 
settings. All channel data is displayed on the scope.

• Clear (uncheck) the desired channel or reference line in the Channel controls to hide 
that signal.
The Signal Information at the top of the scope display is updated to remove the chan-
nel settings. No channel data is displayed on the scope.
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Horizontal Controls

Adjust the horizontal update period.

Figure 2-17: Horizontal Controls

1. In the Horizontal controls section, select the desired update rate from the Update 
Period menu.

The selected Update Period is displayed.

NOTE: The maximum amount of data that can be collected for display is 10,000 
points per channel at the specified update rate.

The Update Period determines the maximum time for display of collected 
data (that is, an Update Period of 1 ms is limited to data collection for 
10 seconds, once every 1 ms). If the maximum time entered exceeds the 
range that is specified by the Low and High limits, the High limit is reduced.

2. Select the desired lower limit for the horizontal axis minimum in seconds (data collec-
tion start point) by selecting the arrow controls on the Low limit control or enter a 
value directly into the text box.

NOTE: If the lower limit entered or selected would cause the total display to be 
larger than the 10,000 points per channel limit, the Low limit setting is auto-
matically reduced and the new value is displayed.

The specified lower limit is displayed.

3. Select the desired upper limit in seconds (horizontal axis maximum) by selecting the 
arrow controls on the High limit control or enter an upper limit value directly into the 
text box.

NOTE: If the upper limit entered or selected would cause the total display to be 
larger than the 10,000 points per channel limit, the High limit setting is auto-
matically reduced and the new value is displayed.

The specified or adjusted upper limit is displayed.
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Trigger Control

Adjust the type of trigger (if selected), channel, and level.

Figure 2-18: Trigger Controls

1. In the Trigger controls section, select the channel to use as a trigger from the SRC 
menu.

The selected channel is displayed.

2. Select the level to be used for triggering by selecting the arrow controls on the Level 
control or enter a trigger value directly into the text box.

The specified trigger level is displayed.

3. Enable the Trigger for the channel if needed by clicking the Trigger setting or move 
the rotary control to that setting.
• Off – No trigger is used for the scope display.
• On – The specified channel and level are used to trigger the scope display.

4. Specify Trigger Type if a trigger is being used, by clicking the Edge setting or move 
the rotary control to that setting.

• Rise – Data on all selected channels is displayed when the signal rises above 
the specified level.

• Fall – Data on all selected channels is displayed when the signal falls below 
the specified level.

IMPORTANT Make sure the trigger level that is specified is within
the limits of the signal.
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Vertical Controls

Adjust the vertical position and signal conditioning of each channel and the vertical positions 
of the reference lines.

Figure 2-19: Vertical Controls

1. In the Vertical controls section, select the desired Channel by clicking the channel 
number or moving the rotary control to that channel.

2. Select the desired vertical scale for the channel by selecting the arrow controls on the 
Scale control or enter a scale value directly into the text box.
The Signal Information at the top of the scope display is updated to show the speci-
fied scale and the scope display is updated to show the signal at the new scale.

3. Select the desired vertical offset for the channel or reference line by selecting the 
arrow controls on the Offset control or enter an offset value directly into the text box.
The Signal Information at the top of the scope display is updated to show the speci-
fied offset and the scope display is updated to show the signal at the new offset.

4. Select the desired Signal Coupling for the channel in the Vertical controls by clicking 
the coupling setting or move the rotary control to that setting.
• AC – Blocks the DC component of the signal, centering the waveform at 0.
• DC – Shows the input signal with any DC offset.
The Signal Information at the top of the scope display is updated to show the coupling 
type.

5. Enable the signal Filter for the channel in the Vertical controls if needed by clicking 
the filter setting or move the rotary control to that setting.
• Off – Filtering is not used for the selected channel.
• On – Shows the input signal with the filter that is defined for that channel (see 

Noise Reduction Filter to configure the filter).
The Signal Information at the top of the scope display is updated to show the filtering 
status.
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View Data
This section describes the options for viewing the data that is currently displayed on the scope 
for performance monitoring.

Zoom

The Virtual Scope provides several options to zoom in or out on the data being displayed. In 
each case, the Zoom option must first be selected from the View menu.
• To enter Zoom mode, select Zoom from the View menu.

The Zoom menu item is checked and the zoom controls, which are shown in Fig-
ure 2-20, are displayed on the upper-right corner of the plot area in the scope display.

Figure 2-20: Zoom Controls

• To exit Zoom mode, select Zoom from the View menu.
The Zoom menu item is cleared and the zoom controls stop being displayed.

• To save an image of the plot area, select the output icon from the zoom controls and 
scroll down to the desired option.
• To save the current plot area display as a bitmap image (PNG, JPG, or TIF, or as 

a vector image in a PDF), select Save As (the disk icon).
• To copy the current plot area display as a bitmap image to the clipboard, select 

Copy as Image (the picture icon).
• To copy the current plot area display as a vector image to the clipboard, select 

Copy as Vector Graphic (the drawing icon).
• To move the display, select Pan (the hand icon) from the zoom controls. Place the 

hand cursor on the plot and click-and-drag the mouse to move the display. When done, 
select Pan to deselect it.

• To zoom in, select Zoom In (the magnifying glass icon with a plus sign) from the 
zoom controls. Place the magnifying glass cursor where the center of the plot should 
be once enlarged and left-click the mouse or rotate the mouse scroll wheel for-
wards/up. When done, select Zoom In to deselect it.
Each mouse click or scroll wheel click zooms in the display and recenters the display 
where the cursor is located.

Pan
Restore View

Zoom Out

Zoom In

Output

Save As
Copy as Image

Copy as Vector Graphic
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• To zoom in to a specific region, select Zoom In (the magnifying glass icon with a plus 
sign) from the zoom controls. Place the cross-hair cursor at one corner of the area to be 
enlarged then click-and-drag the mouse to create a box. Release the mouse button, to 
zoom to the specified area. When done, select Zoom In to deselect it.

The display is recentered and zooms in to the region enclosed by the box.

• To zoom out, select Zoom Out (the magnifying glass icon with a minus sign) from the 
zoom controls. Place the magnifying glass cursor where the center of the plot should 
be once reduced and left-click the mouse or rotate the mouse scroll wheel back-
ward/down. When done, select Zoom Out to deselect it.

Each mouse click or scroll wheel click zooms out the display and recenters the display 
where the cursor is located.

• To restore the display to its original state while in Zoom mode, select Restore View 
(the house icon) from the zoom controls.

The display is returned to its original settings and Zoom mode stays enabled.

Measurement

The Virtual Scope provides a tool to identify the value of a specific signal at a specific loca-
tion.

1. To enter Measurement mode, select Measurement from the View menu.
The Measurement menu item is checked and the cursor changes to a cross hair each 
time it is placed over a signal.

2. To make a measurement, click the desired signal at the required time.
The data point is identified with a marker and a popup is displayed showing the time 
and amplitude of the signal.

• The data point marker can be dragged along the signal by selecting it and drag-
ging it to a new location. Selecting another signal moves the data point marker 
to that signal.

3. To exit Measurement mode, select Measurement from the View menu.
The Measurement menu item is cleared, the data popup is closed, and the cursor stays 
a pointer when placed over a signal.

Set Y-Axis Limit

The Y-axis limits can be either user-defined or automatically defined by the data being dis-
played.
• To select automatic sizing of the Y-axis, select Auto Limit from the View menu.
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The Auto Limit menu item is checked and the display is constantly updated to make 
sure that all data is displayed within the Y-axis boundaries.

• To configure fixed sizing of the Y-axis, select Set Fixed Limit… from the View 
menu.
The Set Fixed Limit… menu item is checked, the Auto Limit menu item is cleared, and 
the Setup Y-Axis Limit dialog box is displayed as shown in Figure 2-21.

Figure 2-21: Setup Y-Axis Limit Dialog Box

1. Specify the limit to be used. The value that is entered is used as both the upper 
and lower Y-axis limits.

2. Select OK to accept the change or Cancel to discard the change.
The display is updated with the Y-axis boundaries set as specified.

Grid Lines

Grid lines can be displayed or removed from the display by selecting Grid Lines from the 
View menu. When Grid Lines is checked, the background grid is displayed. When Grid 
Lines is cleared, the background grid is not displayed.

Noise Reduction Filter

The noise reduction filter used to smooth the vertical amplitude of any signals that have Fil-
tering turned on can be adjusted to provide different amounts of smoothing. Each channel can 
have a unique filter configured.

1. Specify the channel to be filtered by selecting it in the Vertical Controls.

2. Select Set Filter Level… from the View menu to configure the Y-axis filter.
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The Set Filter Level dialog box is displayed as shown in Figure 2-22.

Figure 2-22: Setup Noise Reduction Filter Dialog Box

3. Specify the filter level to be used. The value that is entered specifies the number of 
samples to use.

4. Select OK to accept the change or Cancel to discard the change.

The filter for the channel is updated with the level set as specified.

Any signals that have Filter turned on in the Vertical Controls section has each point 
being displayed filtered using a Median Filter. This filter uses the raw data from the 
points ahead of and behind each point by the amount that is specified in the dialog box.

NOTE: When the filter is turned on, the number of points that are specified in the Set 
Filter Level dialog box are not displayed at the beginning or end of the trace 
since the required number of points for filtering are not available.
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Save and Review Data

This section describes how to save and review the data that is displayed on the scope. Only the 
data for the data range currently being displayed (not affected by zoom) can be saved.

Save Screen Capture of the Virtual Scope Utility

A screen capture of the Virtual Scope display can be saved as a graphics file at a specified 
location. All standard graphics formats are supported.

NOTE: Screen captures can only be saved when the scope is not collecting data.

• To save a screen capture of the full scope display in a bit-mapped format:

1. Stop the scope when the appropriate data is being displayed by selecting Stop.

2. Stop any data recording by selecting Stop REC.

3. Select Save Screen… from the Tools menu.

The Save screen capture as dialog box is displayed.

4. Use the dialog box controls to select the location for the screen capture file.

5. Use the dialog box controls to specify the file type.

6. Enter a name for the file and select Save.

The screen capture is saved in the specified format and location.

• To save a screen capture of just a selected portion of the scope plot area as either a 
bit-mapped or vector format image:

1. Stop the scope when the appropriate data is being displayed by selecting Stop.

2. Select Zoom from the View menu.

The Zoom Controls are displayed when the cursor is placed in plot area.

3. Adjust the scope display using the zoom tools.

4. Save the scope plot area using the Output icons:

• Save As (the disk icon), opens a dialog box to save the scope plot area 
to the selected location in the selected file format (PNG, JPG, TIF, 
PDF).

• Copy as Image (the picture icon), copies the scope plot area to the 
Windows clipboard as a bit-mapped image.

• Copy as Vector Graphic (the drawing icon), copies the scope plot area 
to the Windows clipboard as a vector image.
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Save Current Virtual Scope Data

Data files that contain the data points for each of the eight channels, even if they are not being 
displayed, can be saved at a specified location. This saves both a screen_data.vsdata file (for 
use by the Virtual Scope) and a comma-separated text file (screen_data.csv) for use in other 
documents or as historical reference. Both files are always exported. The signal data for each 
channel is exported even if it is not being displayed.

The CSV file is exported as a text file organized into nine columns. The first column is the 
time that the data was recorded. The remaining columns are the signal data (starting at the left 
of the screen).

NOTE: Data is only captured for the current data set. To capture data as it is received while 
the scope is collecting data, see Save Virtual Scope Data to a Log File.

1. Stop the scope when the appropriate data is being displayed by selecting Stop.

2. Stop capturing data to the log file by selecting Stop REC.

3. Select Export Screen Data… from the Tools menu.
NOTE: The screen data files can only be saved when the scope is not collecting data.
The Save Screen Data as dialog box is displayed.

4. Use the dialog box controls to select the location for the data files.

5. Enter a name for the files and select Save.
The Screen Export dialog box is opened to allow entry of descriptive information that 
is related to the data export.

6. Enter a description of the data being saved.

• Select OK to add the notes into the screen_data.vsdata and the screen_
data.csv files and start the data export.

• Select Cancel to start the data export without any notes.

The data is saved as both a vsdata file and a CSV file in the specified location.

Save Virtual Scope Data to a Log File

A running log that contains the data points for each of the eight channels, even if they are not 
being displayed, can be saved at a specified location.

NOTE: If a data capture log file is not defined, the Virtual Scope uses the default data_cap-
ture.csv file that is in the folder where the Virtual Scope executable is located.

Data is only captured as it is received while the scope is collecting data. To capture 
the data for the current screen image, see Save Current Virtual Scope Data.
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1. Select Setup Data Capture… from the Tools menu.

NOTE: The log file can only be defined when the scope is not collecting data.

The Pick a data capture file dialog box is displayed.

2. Use the dialog box controls to select the location for the data file.

3. Enter a name for the file and select Save.

The name of the data capture log file is displayed in the Information Panel and the 
data is saved as a CSV file in the specified location.

4. Capture data to the log file as required.

• Select Record to append all Virtual Scope data to the currently defined data 
capture log file as the data is captured.

The Screen Export dialog box is opened to allow entry of descriptive informa-
tion that is related to the data capture.

1. Enter a description of the data being saved.

• Select OK to add the notes into the screen_data.vsdata file and 
the screen_data.csv file and start the data export.

• Select Cancel to start the data export without any notes.

The data is appended to the data_capture.csv file in the specified location.

• Select Stop REC to stop capturing data to the log file.

Review Data Using the Virtual Scope Utility

To review a previously saved screen_data.vsdata file using the Virtual Scope utility, load the 
desired file into the scope.

1. Select Load Screen Data… from the Tools menu.

NOTE: The screen data files can only be loaded when the scope is not collecting 
data.

The Select Screen Data dialog box is displayed.

2. Use the dialog box controls to select the desired screen_data.vsdata file and select 
Open.

The previously saved scope data is loaded and displayed as a scope plot. Information 
about the plot, including any descriptive information added when the data was saved 
is displayed in the Information Panel.

3. Review the data as required by adjusting the Horizontal controls, the Vertical con-
trols, the Channel controls, and the Zoom.
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Review Data Using an External Application

To review a previously saved screen_data.csv file or a data_capture.csv file using Excel or 
any other application, load the desired file into the application.

1. Start the desired application.

2. Select Open.

The Open dialog box is displayed.

3. Use the dialog box controls to select the desired screen_data.csv file and select Open.

The previously saved scope data with any descriptive information is loaded. If the file 
is a data_capture.csv file, descriptive information that is related to the capture is 
included.

4. Review the data as required.
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Application Notes 3

Overview

This chapter provides examples and step-by-step procedures that are related to specific tasks 
using MagneMotion® Virtual Scope.

Application Notes are provided for specific tasks in the operation of the Virtual Scope. Simple 
step-by-step procedures and examples for each application that is covered are provided. These 
procedures reference detailed information about the steps that is located elsewhere in this 
manual.

Included in this chapter are:

• Tuning Motor Performance.

• System diagnosis.
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Tuning Motor Performance

Tuning Overview

This section describes how to use the Virtual Scope to help when tuning the control loop for 
the LSM motors in a MagneMotion transport system. The motors use a Proportional Integral 
Derivative (PID) controller for closed loop feedback to control motion. The equation is shown 
in Figure 3-1.

Figure 3-1: PID Controller Equation

The control loop can be tuned for specific movement characteristics by adjusting the constants 
P, I, and D as shown in Figure 3-2 and described after the figure.

Figure 3-2: PID Controller Diagram

1. At the start of a move, the initial profile, Xprofile, is fed into the controller.

2. The acceleration, A, is multiplied by a feed forward constant, Kff.

3. The position error, ex, is the discrepancy between the current position and the current 
destination. This error goes through the Proportional, Integral, and Derivative opera-
tions.

4. The feed forward and PID results are combined and multiplied by the mass constant, 
M.

5. The result is used to generate the appropriate movement to decrease the position error.

6. The new position, Xactual, is fed back into the control loop. It is then subtracted from 
the destination position to generate the new position error to be operated upon.
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Tuning Goals

The PID loop settings, and therefore the waveform being displayed can vary based on the 
goals of the system. There are four common tuning goals:

• Fast Settling Time – Valuable in high throughput or high precision applications.

• Low Overshoot – Valuable in applications involving delicate materials or specific 
hardware configurations.

• Low Steady State Error or High Stability – Valuable in high precision applications.

• Fast Rise Time – Valuable in high throughput applications.

It is not possible to tune for all four goals. For example, when tuning for fast settling time, 
high stability, and fast rise time, the resulting wave form (and PID loop) has a high overshoot 
as shown on the left in Figure 3-3. Similarly, tuning for fast settling time, low overshoot, and 
high stability, the resulting wave form (and PID loop) has a slow rise time as shown on the 
right in Figure 3-3.

Figure 3-3: Tuning Goals

Table 3-1 shows the general effects that each PID parameter has on the waveform that vehicle 
motion generates. The mass parameter amplifies the effect of each of the PID parameters, and 
can be thought of as a scaling factor.

Table 3-1: PID Parameter Waveform Effects

Parameter Rise Time Overshoot Settling 
Time

Steady-State 
Error

Proportional Gain (Kp) Decrease Increase No Trend Decrease

Integral Gain (Ki) Decrease Increase Increase Eliminate

Derivative Gain (Kd) No Trend Decrease Decrease No Trend

Fast Settling, High Stability, Fast Rise
High Overshoot

Fast Settling, Low Overshoot, High Stability
Slow Rise
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Tuning Process

To tune the PID controller, start with the default set of PID values in the Configuration File. 
Create a host controller task or an NCHost demo script to have a vehicle repeatedly replicate 
the desired vehicle motion that is being tuned. That is, vehicle payload, velocity, acceleration, 
direction, and destination should be the same as during system operation.

Adjust the PID parameters and gauge their effect on the vehicle motion by reviewing the 
waveforms on the Virtual Scope. Continue to adjust the PID parameters until a PID set that 
gives the desired motion performance is determined. When tuning the PID loop, vary the mass 
parameter to reflect the mass of the vehicle and load. Additionally, change only one parameter 
at a time, which makes it easier to track and adjust the effect that the change produces. For 
example, if P and I are changed simultaneously and vehicle movement becomes unfavorable, 
it is not obvious whether that behavior came from the change to P, I, or both.

It is easier and faster to tune the PID loop by using NCHost to adjust the PID values temporar-
ily rather than repeatedly changing and reuploading the Configuration File.

This procedure provides an overview of the tuning process.

1. Run the MagneMotion Configurator and load the system Node Controller Configura-
tion File (see either the MagneMover LITE Configurator User Manual, MMI-UM008, 
or the QuickStick Configurator User Manual, MMI-UM009).
• Record the vehicle mass for both loaded and unloaded vehicles.
• Record the control loop PID values for the path being monitored for both 

loaded and unloaded vehicles and any other PID Sets to be tested.

2. Exit from the Configurator.

3. Run the NCHost TCP Interface Utility (see the NCHost TCP Interface Utility User 
Manual, MMI-UM010).

A. Connect to the HLC for the transport system.

B. Startup or reset the motors.

4. Run the Virtual Scope utility.

A. Select the appropriate Motor Mode (see Single Motor Monitoring on page 35 
or Multiple Motor Monitoring on page 37).

B. Monitor the waveforms that are displayed (see View Data on page 46).

5. Enter the original PID values from the Node Controller Configuration File and 
observe the behavior of the vehicle.

A. In the NCHost TCP Utility window, select Control Loop under Engineering 
Tools.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um008_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um009_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um010_-en-p.pdf
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The Tune Control Loop Parameters dialog box open.

B. Select a PID Set Index for the values.

C. Enter the Path ID where the motors are located, the current PID values from 
the Configuration File, the mass value for the current state of the vehicle, and 
select Test New Parameters to enter the values.

D. Move a vehicle on the monitored motors by running either a task on the host 
controller or a Demo Script using NCHost.
The channels show the default behavior of the motors.

6. Adjust the PID values and observe the changes to the behavior of the vehicle.

A. In the NCHost TCP Utility Tune Control Loop Parameters dialog box, enter 
the new PID values and select Test New Parameters to test the values.

B. Move a vehicle on the monitored motors by running either a task on the host 
controller or a Demo Script using NCHost.
The channels show the new behavior of the motors.

7. To reset the PID values to their defaults, enter the defaults values from the Node Con-
troller Configuration File or restart the node controller.

8. To save the new PID values, run the MagneMotion Configurator and load the system 
Node Controller Configuration File.

A. Enter the new control loop PID values using the values from the PID Sets 
tested.

B. Upload the revised Node Controller Configuration File to all node controllers 
in the transport system.
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Tuning Waveforms

The waveform example in Figure 3-4 shows the relationship between vehicle velocity and 
position as the vehicle moves from a stop to full velocity, then slows to a stop.

Figure 3-4: Position and Velocity Waveform
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The waveform example in Figure 3-5 shows the settling performance at a station or destina-
tion position by triggering on the edge of the Settling Error.

Figure 3-5: Edge Trigger Waveform
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Tuning Reactions

PID tuning using the Virtual Scope involves increasing or decreasing certain wave form ele-
ments. These elements are shown in Figure 3-6.

• Rise time – The time it takes for the vehicle to go from moving to being within toler-
ance of its goal position.

• Overshoot – The maximum distance by which the vehicle passes the goal position 
before returning.

• Settling time – The time between crossing the goal position and settling at the goal.

Figure 3-6: Waveform Elements

Steady state error is another common wave form element as shown in Figure 3-7. It is the dis-
tance that the vehicle maintains from its goal position.

Figure 3-7: Steady State Waveform
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The ability to remain at the goal position indicates stability. Significant instability can result in 
a resonant wave form, or wave of increasing amplitude as shown in Figure 3-8. Instability 
may occur if the Proportional and/or Integral parameters are too high.

Figure 3-8: Waveform Showing Instability

Additional Tuning Options

When creating the Node Controller Configuration File using the Configurator, the state of the 
Ki parameter, or integrator, can be configured. The integrator options are; always on, off when 
the velocity of a vehicle is above a defined value, or off when the position of the vehicle is 
within a defined threshold as shown in Figure 3-9. These options are only available through 
the Advanced Parameters section of the Motor Defaults or for specific motors on each path. 
Show Advanced Parameters must be selected in the Options menu of the Configurator to 
display the Integrator options. See either the MagneMover LITE Configurator User Manual, 
MMI-UM008, or the QuickStick Configurator User Manual, MMI-UM009 for detailed infor-
mation on these configuration options.

Figure 3-9: Integrator Configuration

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um008_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um009_-en-p.pdf
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System Diagnosis

Diagnosis Overview

This section describes how to use the Virtual Scope to help detect and identify problems with 
drive coils, position sensors, or position magnets. As a vehicle moves over a motor, signals 
corresponding to the position of the vehicle and to the current commanded in each drive coil 
are monitored and stored using the Virtual Scope. Analysis of these signals identifies whether 
one of the position sensors on the motor or one of the drive coils on the motor, used to propel 
the vehicle along the track, has failed.

Detecting Coil Failure

A linear motor includes a number of coils that are spaced along the motor body. The coils are 
activated to cause a vehicle to travel along the motor. Each coil is activated only when a vehi-
cle passes over the coil. The momentum of the vehicle allows the vehicle to continue traveling 
across any one coil that may fail, and coils that are adjacent to a failed coil may compensate, 
at least in part, for a failed coil. However, the extra current applied to the adjacent coils to 
compensate for a failed coil may result in accelerated failure of those coils.

Monitor the current drawn by each coil to move the vehicle as commanded as a vehicle passes 
over the motor. Compare that current data from the motor to historical current data from that 
motor or the data from all other motors in the transport system. Use that comparison to iden-
tify those coils that are drawing extra current, or those that are not drawing enough current and 
generate a fault signal.

Detecting Position Sensor Failure

A linear motor may employ one or more position magnets on each vehicle and an array of 
position sensors that are spaced along the motor to detect the position magnets on each vehicle 
as it passes. Failure of one position sensor may go undetected as adjacent position sensors are 
able to compensate and provide position information for each vehicle. However, failure of a 
position sensor results in positioning errors, which leads to unwanted vehicle motion.

Monitor the position feedback signal from each of the position sensors on a motor as a vehicle 
passes over the motor. Compare that sensor data from the motor to historical sensor data from 
that motor or from all other motors in the transport system. Use that comparison to identify 
those sensors that are not detecting the magnet array correctly and generate a fault signal.

Detecting Magnet Array Failure

A linear motor may employ one or more position magnets on each vehicle and an array of 
position sensors that are spaced along the motor to detect the position magnets on each vehicle 
as it passes. In MagneMotion motors, the propulsion magnet array is also used as the position 
magnet array. Failure of one magnet on a vehicle may go undetected as the position sensors in 
the motor are able to compensate and provide position information for each vehicle. However, 
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failure of magnet array results in from reduced motion performance up to interruption of 
motion.

Monitor the position feedback signal from each of the position sensors on a motor as a vehicle 
passes over the motor. Compare the position feedback signal from the motor for that vehicle to 
historical feedback signal data for that vehicle or from all other vehicles in the transport sys-
tem. Use that comparison to identify those magnet arrays where the position signal differs and 
generate a fault signal.
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UI Reference 4

Overview

This chapter provides an overview of the User Interface (UI) for the Virtual Scope utility with 
examples of each window, page, and dialog in the UI and a complete description of their fea-
tures. The following parts of the User Interface are covered:

• User Interface Window Layout.

• User Interface Features.

• Window and Dialog Box Reference.
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Window Layout

All User Interface (UI) elements that are presented through the Virtual Scope utility window 
follow the guidelines that are described here. The UI consists of two main areas that are 
always visible as shown in Figure 4-1, and temporary dialog boxes that are displayed over the 
main UI window.

Figure 4-1: Window Layout

Window Behavior
• Window Size – The window can be enlarged as required to change the size of the 

scope display without affecting the size of the scope controls. The window opens at its 
default size and location each time the Virtual Scope utility is run.

• Pane Size – None of the sections of the window can be moved or resized.

Scope Display

Virtual Scope Menus and Window Controls

Scope Controls
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User Interface Features

Dialog Boxes

Dialog boxes (shown in Figure 4-2) are used to select options, input information, and start 
operations. Dialog boxes are displayed when certain functions (for example, buttons that 
allow user input) are selected in the current window or dialog box. The dialog box that is dis-
played depends on the type of input that is required.

To close a dialog box and save the selection, select the button for the dialog box’s action 
(Open, OK, and so forth). To close a dialog box without saving, select Cancel.

NOTE: When certain dialog boxes are open, no actions are permitted until the dialog box is 
closed.

Figure 4-2: Dialog Box Example

Dialog Box and Window Elements

Checkboxes (shown in Figure 4-3) are used to enable or disable an option. Placing the cursor 
over the checkbox and selecting it, either displays a check mark in the box (selected), or 
removes the check mark from the box (cleared). In those areas where multiple checkboxes are 
presented, multiple checkboxes can be selected.

Figure 4-3: Checkbox Example

Drop-down menus or list boxes, similar to the ones shown in Figure 4-4, are used to select one 
option from a list of available options. A drop-down menu or list box is used when no confir-
mation of the selection is required; once an option is selected, it is immediately activated.

Figure 4-4: Drop-Down Menu Examples
Drop-Down List Box

Drop-Down Menu
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Text fields (shown in Figure 4-5) are used to enter variable information, such as names, set-
points, and position values. Display fields (shown in Figure 4-5) are used to display fixed and 
variable information, such as menu selections, property names, and values returned from the 
controlled components.

Figure 4-5: Text and Display Field Example

Each window and dialog box contains graphical buttons (shown in Figure 4-6) that are used to 
perform various actions, including:

• Initiating an action.

• Selecting values.

• Opening dialogs or menus.

Figure 4-6: Button Examples

Display Field

Text Field

Command Button
(Initiate Action)

Arrow Buttons
(Select Value)

Arrow Button
(Open Drop-Down Menu)

Rotary Buttons
(Select Value)
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Window and Dialog Box Reference

This reference provides a detailed description of each window, page, and dialog box displayed 
by the Virtual Scope utility. All windows, menus, and dialog boxes within this reference are 
listed in functional order.

Main Window

The Window for the Virtual Scope utility is shown in Figure 4-7. All window functions are 
described after the figure. All functions that are accessed through this window are discussed 
following the Main Window.

This Window provides access to all functions of the utility. The function of each item in the 
window and the properties for those items are described in this chapter.

Figure 4-7: Virtual Scope Utility Window Overview

• Main Menu – Provides drop-down menus for various Virtual Scope utility options.

• Channel Control and Signal Information – Provides a tool for selecting the signals 
to be displayed and identifies their display settings.

• Scope Display – Displays the signal traces and axis information.

• Information Panel – Provides scope status.

• Run Controls – Provides access to the setup and operating functions.

• Horizontal Controls – Provides tools for configuring the horizontal axis (X) of the 
scope display.

Run
Controls

Vertical
Controls

Scope

Main
Menu

Display

Trigger
Control

Horizontal
Controls

Information
Panel

Channel
Control

and
Signal

Information
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• Trigger Control – Provides tools for configuring the scope trigger.

• Vertical Controls – Provides tools for configuring the vertical axis (Y) for each signal 
being displayed.
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Main Menu

The Main Menu (see Figure 4-8), at the top of the Virtual Scope utility as shown in Fig-
ure 4-7, provides the drop-down menus that are shown in Figure 4-9 for access to various 
functions.

Figure 4-8: Main Menu

Figure 4-9: Virtual Scope Menus

File

• Load… – Opens a dialog box to locate and open an existing scope_config.xml file.

• Save As… – Saves the current scope configuration to a new scope_config.xml file 
with a user specified name at the specified location.

• Quit – Closes the Virtual Scope window without saving any data.

• Exit – Closes the Virtual Scope window after any data collection is stopped.

View

• Zoom – When selected (checked), turns on Zoom mode and displays the zoom con-
trols, which are shown in Figure 4-10, on the upper-right corner of the plot area in the 
scope display when the cursor is placed in the plot area. The Low Limit and High 
Limit text fields in the Horizontal controls turn red to indicate that those values do not 
apply while in zoom mode. Must be cleared (unchecked) to exit Zoom mode.

Figure 4-10: Zoom Controls

File Menu View Menu Tools menu Advanced Menu Help Menu

Pan
Restore View

Zoom Out

Zoom In

Output

Save As
Copy as Image

Copy as Vector Graphic
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• Output – Saves an image of the plot area.

• Save As – Opens a dialog box to save the current plot area display as a 
bitmap image as either a PNG, JPG, or TIF file or as a vector image as a 
PDF file.

• Copy as Image – Copies the current plot area display as a bitmap 
image to the clipboard.

• Copy as Vector Image – Copies the current plot area display as a vec-
tor image to the clipboard.

• Pan – When selected, the icon highlights and the cursor changes to a hand. 
Click and drag the image in the plot area to another position. Click the icon to 
deselect.

• Zoom In – When selected, the icon highlights and the cursor changes to a 
cross hair. Click in the plot area to zoom in centered on the cross hair. Click 
and draw a box in the plot area to define an area to zoom into. Roll the mouse 
wheel to zoom in or out. Click the icon to deselect.

• Zoom Out – When selected, the icon highlights and the cursor changes to a 
magnifying glass. Click in the plot area to zoom out. Roll the mouse wheel to 
zoom in or out. Click the icon to deselect.

• Restore View – Restores the display in the plot area to its default zoom and 
position.

• Measurement – When selected (checked), the cursor changes to a cross hair, which 
allows selection of a point on any of the signals being displayed. Once the trace is 
selected, a data point marker is placed at that location and a popup is displayed show-
ing the value of that signal at the time point selected. Once a signal is selected, the data 
point marker can be dragged to anywhere on the signal.

• Auto Limit – When selected (checked), continually sizes the vertical axis (Y) of the 
scope display to fit all data. When cleared, the vertical axis of the scope display is 
sized to the limit specified in Fixed Limit.

• Set Fixed Limit… – Opens a dialog box for setting the vertical (Y) axis limits as 
shown in Figure 4-11.

Figure 4-11: Setup Y-Axis Limit Dialog Box

• Low – Text field for the entry of the lower Y-axis limit.
• High – Text field for the entry of the upper Y-axis limit.
• OK – Accepts the axis change and closes the dialog box.
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• Cancel – Cancels the axis change and closes the dialog box.

• Grid Lines – When selected (checked), turns the grid lines on the scope display ON. 
When cleared, turns the grid lines on the scope display OFF.

• Set Filter Level… – Opens a dialog box for setting the Noise Reduction Filter as 
shown in Figure 4-12.

Figure 4-12: Setup Noise Reduction Filter Dialog Box

• Levels – Text field for entry of an integer value to use for the noise reduction 
filter used in the Vertical Control. If a non-integer value is entered, a value as 
close to the entered value as possible is used.

• OK – Accepts the filter change and closes the dialog box.

• Cancel – Cancels the filter change and closes the dialog box.

• Reset Window Size – Returns the Virtual Scope window to its default size and loca-
tion.

Tools

• Setup Data Capture… – Opens a dialog box to define the name and location of the 
data capture log (data_capture.csv). This log contains the data points for each of the 
eight channels even if they are not being displayed. Recording data to the log is con-
trolled through the Record button. Data is appended to the log each time Record is 
selected.

• Save Screen… – Opens a dialog box to save a screen capture of the Virtual Scope dis-
play as a graphics file at the specified location. All standard bitmap graphic formats 
are supported.

• Export Screen Data… – Opens a dialog box to save the data from all channels in the 
current display, including any channels that are not being displayed. The data is saved 
it two formats:

• CSV – A comma delineated text file that contains the data points for each of 
the eight channels. This file can be imported into other applications such as 
Excel for review.

• vsdata – An XML file that contains the data points for each of the eight chan-
nels. This file can be imported into the Virtual Scope utility for review.

• Load Screen Data… – Opens a dialog box to locate and open an existing Screen Data 
file (*.vsdata) for display.
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Advanced

• Load Data Stream… – Opens a dialog box to review the existing Data Stream config-
uration and load another configuration as shown in Figure 4-13.

Figure 4-13: Data Stream Configuration Dialog Box

• Data Stream Information – Displays the current motor type, motor code ver-
sion, stream data type, block index, and channel definitions.

• Load Stream Configuration from Disk – Opens a dialog box to locate and 
open an existing Data Stream Configuration file.

• OK – Accepts the loaded Data Stream Configuration file and closes the dialog 
box.

• Cancel – Cancels loading the Data Stream Configuration file and closes the dia-
log box.

• Single Motor Mode – When selected (checked) configures the scope to monitor the 
change of performance parameters of one motor on a specified path. When cleared 
(unchecked) configures the scope to monitor the change of performance parameters of 
multiple motors on a specified path. This selection determines the options available in 
the Setup Scope Data Collection dialog box (see Figure 4-18).

Help

• Help… – Displays the help information system.
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• About MMI Virtual Scope… – Displays version information for the Virtual Scope as 
shown in Figure 4-14.

Figure 4-14: About MagneMotion Virtual Scope Message
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Scope Display

The Scope Display (see Figure 4-15), on the left of the Virtual Scope window as shown in 
Figure 4-7, displays the signal traces, identifies the signals being displayed, and displays axis 
information.

Figure 4-15: Scope Display

Signal Information – Displays the names of all signals and their vertical scale per division, 
coupling, filtering, and any offset. The settings are not displayed if the signal is not being dis-
played (checkbox is cleared). The checkbox before each signal determines the display status 
for the signal (select (check) to display).

Vertical Axis – Displays the current vertical axis (Y). When Fixed Limit is being used, the 
axis extends to the limits set in the Set Y Axis Limits dialog box. When Auto Limit is being 
used, the axis automatically centers around the signals on the display and extends to include 
all signals on the display.

Horizontal Axis – Identifies the amount of time displayed (in seconds). This axis can be 
adjusted using the Low limit and High limit controls.

Screen Display – Displays the waveforms for the selected signals.

Signal
Information

Vertical
Axis (Y)

Horizontal
Axis (X)

Screen
Display
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Information

The Information Panel (see Figure 4-16), at the top of the Scope Controls pane, as shown in 
Figure 4-7, provides scope status.

Figure 4-16: Information Panel

• Information Panel – Display field that shows a log of Virtual Scope operation infor-
mation. The text that is displayed can be copied and pasted into another application 
(for example, a text editor).
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Run Controls

The Run Controls section (see Figure 4-17), in the middle of the Scope Controls pane, as 
shown in Figure 4-7, provides access to the scope setup and control functions.

Figure 4-17: Run Controls

• SETUP – Opens the Setup Scope Data Collection dialog box (see Figure 4-18) to 
configure the Virtual Scope. The Single Motor Mode setting on the Advanced menu 
determines the functions that are available through the dialog box. This function is not 
available while the scope is collecting data.

Figure 4-18: Setup Scope Data Collection Dialog Box

• HLC IP – Text field for the entry of the IP address of the high-level controller.

Status Indicator

Single Motor Mode Selected

Single Motor Mode Not Selected
(Multiple Motor Mode)
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• Web – Opens the node controller Web Interface for the HLC specified in HLC 
IP in the default web browser for the computer. Only available in Multiple 
Motor Mode.

• Load Config File from Disk – Opens a dialog box to locate and load the Node 
Controller Configuration File for the transport system being monitored. Only 
available in Multiple Motor Mode.

• Path Information – Displays a list of all motors on the path that is specified in 
Path Select in their order on the path as defined in the Node Controller Con-
figuration File loaded through Load Config File from Disk. The type and 
length of each motor is displayed, including any Downstream Gap. Only avail-
able in Multiple Motor Mode.

• Vehicle Select by ID – Specifies the vehicle (as assigned by the HLC) to mon-
itor.

• Path Select – Text field for entry of the path where the motor and vehicle to 
monitor are located.

• Motor Select – Text field for entry of the motor on the selected path to moni-
tor. Multiple motors can be monitored by listing them with a space between the 
ID for each motor. Entering “0” selects all motors on the path that is specified 
in Path Select.

• OK – Accepts the configuration changes and closes the dialog box.
• Cancel – Cancels the configuration changes and closes the dialog box.

• RUN/STOP – Starts/stops data collection on the specified vehicle from the specified 
motor. Any data collected while running continues to be displayed once data collection 
is stopped.

• Status Indicator – An indicator in the RUN button that turns green to indicate a good 
connection to the motors defined in the Setup Scope Data Collection dialog box.

• Record/Stop REC – Starts/stops recording to the log that contains the data points for 
each of the eight channels, even if they are not being displayed. The new data is 
appended to the end of the existing file unless a new file is specified. Each time the log 
is started the Screen Export dialog box opens to allow entry of descriptive informa-
tion that is related to the data capture.

Figure 4-19: Screen Export Dialog Box
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• User Notes – Free form text field for entry of any descriptive information 
related to the data being captured.

• OK – Adds any entered notes into the data_capture.csv file before the next set 
of captured data, closes the dialog box, and starts the data capture.

• Cancel – Does not add any additional information into the data_capture.csv 
file, closes the dialog box, and starts the data capture.
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Horizontal Control

The Horizontal Control section (see Figure 4-20), at the bottom of the Scope Controls pane, as 
shown in Figure 4-7, provides tools for configuring the horizontal axis (X) of the scope dis-
play.

Figure 4-20: Horizontal Control Pane

• Update Period – Provides a menu to select the rate that data is being collected from 
the motor (1 ms … 60 s). Can only be changed when data collection is stopped.

NOTE: The maximum amount of data that can be collected for display is 10,000 
points per channel at the specified update rate.

A smaller Update Period collects more data for a shorter amount of time and 
provide finer resolution on the display.

• Low (sec) – Text field for entry of the lower limit for the horizontal axis (data collec-
tion start point). If a value outside of the valid range (>10,000 points) is entered, the 
High value is changed to make it valid. This text field turns red to indicate that the 
value does not apply while in zoom mode.

• High (sec) – Text field for entry of the total time for data being collected and dis-
played (horizontal axis maximum). If a value outside of the valid range (determined by 
the Update Period to a maximum of 10,000 data points) is entered, the value is 
changed to a value as close to the entered value as possible. This text field turns red to 
indicate that the value does not apply while in zoom mode.
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Trigger Control

The Trigger Control section (see Figure 4-21) at the bottom of the Scope Controls pane, as 
shown in Figure 4-7, provides tools for configuring the scope trigger.

Figure 4-21: Trigger Control Pane

• SRC – Provides a menu to select the signal to be used to trigger the display based on 
the trigger settings.

• Level – Text field for entry of the trigger point for the signal. Used when Trigger is set 
to On.

• Trigger – Provides a control to turn on the edge trigger.

• Off – No trigger is used.

• On – The specified edge trigger is used.

• Edge – Provides a control to select the type of edge trigger that is used to start the dis-
play when the specified signal crosses the trigger level in the specified direction.

• Rise – Trigger on a rising edge.

• Fall – Trigger on a falling edge.

IMPORTANT Make sure the trigger level that is specified is within
the limits of the signal.



UI Reference
Window and Dialog Box Reference

Virtual Scope User Manual 85
Rockwell Automation Publication MMI-UM011D-EN-P - January 2022

Vertical Control

The Vertical Control section (see Figure 4-22) at the bottom of the Scope Controls pane, as 
shown in Figure 4-7, provides tools for configuring the vertical axis (Y) for each signal being 
displayed.

Figure 4-22: Vertical Control Pane

• Channel – Provides a control to select any of the eight channels or two reference lines 
for vertical adjustment.

• Scale – Text field for entry of the vertical scale of the selected signal. The scale varies 
the vertical size of the waveform for the signal on the screen. Not all signals are using 
the same units (that is, Position is in meters, Velocity is in meters/second).

• Offset – Text field for entry of the vertical offset of the selected signal. The offset var-
ies the vertical position of the waveform for the signal on the screen. Not all signals 
are using the same units (that is, Position is in meters, Velocity is in meters/second).

• Coupling – Determines which part of the selected signal is displayed.

• DC – Shows the input signal with any DC offset.

• AC – Blocks the DC component of the signal, centering the waveform at 0.

• Filter – Provides a Median Filter for the data from the selected signal. This filter only 
affects the display of the data, it does not affect the actual data being collected. This 
filter uses the raw data from the points ahead of and behind each point by the amount 
that is specified in the Set Filter Level dialog box.

• Off – Disables signal filtering.

• On – Enables signal filtering.
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Channel Control

The Channel Control section (see Figure 4-23) at the top of the Scope Display, as shown in 
Figure 4-7, provides the tool for selecting the parameters to be displayed. This section also 
shows the display status, vertical scale per division, coupling, filtering, and any offset for each 
signal. The parameters available, and the channel they are displayed on is defined in the Data 
Stream Configuration File.

Figure 4-23: Channel Controls

The checkbox before each signal determines the display status for the signal (checked to dis-
play).

• POSITION – The actual position of the vehicle on the motor in meters.

• SET POSITION – The expected position (profile position) of the vehicle on the 
motor in meters.

• TARGET – The position on the motor where the vehicle has been granted move per-
mission in meters (target position). This position is ahead of the vehicle for a vehicle 
that is moving forwards.

• VELOCITY – The actual velocity of the vehicle in meters/second. This is the velocity 
value that is used by the PID control loop. Standard when using DataSet_1 Data 
Streams.

• VEL (LN) – The filtered velocity of the vehicle in meters/second with a Low Noise 
filter applied by the motor. This is the velocity value that is returned to the host con-
troller when using vehicle status commands. Standard when using DataSet_2 Data 
Streams.

• CURRENT – The commanded motor current for the vehicle in Amps. This is the 
amount of current required to move the vehicle as commanded.

• STTL ERR – The Target position - actual Position (settling error), this signal shows 
how well the vehicle position settles relative to the destination position in millimeters.

• TRACK ERR – The Set Position - actual Position (tracking error), this signal shows 
how well the vehicle position follows the profiled position command during its 
motion, in millimeters.

• SET VEL – The commanded velocity (profile velocity) for the vehicle in meters/sec-
ond.

• Y – Reference line for display. The position of the reference line is specified using the 
Offset control in the Vertical functions panel.
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Troubleshooting 5

Overview

This chapter describes the common difficulties that may be encountered when using the Vir-
tual Scope utility. Included in this chapter are:

• Virtual Scope utility troubleshooting.

• Signal troubleshooting.
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Virtual Scope Utility Troubleshooting

This section describes the common difficulties that may be encountered with the MagneMo-
tion® Virtual Scope utility, and general solutions.

Table 5-1: Virtual Scope Utility Troubleshooting

Symptom Problem Solution

The Virtual Scope utility does not 
connect to the HLC even though 
it did previously.

The IP address of the HLC has 
been changed.

Use the host controller or the 
NCHost TCP Interface Utility to 
connect to the HLC to verify the 
address.

The network is not connected or 
there are network problems.

Verify all network connections 
(use the Windows Command 
Prompt to ping the IP address). 
Contact the IT department at the 
facility for additional network 
support.

The Virtual Scope utility discon-
nects from the HLC.

Another device is accessing the 
HLC on TCP port 8000.
The HLC supports only one Vir-
tual Scope TCP connection at a 
time. If a new TCP connection is 
made when there is already an 
established connection, the estab-
lished connection is dropped and 
the new TCP connection is used.

Determine the location of the 
other device and disconnect it.

The Virtual Scope utility becomes 
unresponsive.

The person running the utility 
must have administrator permis-
sion on the computer where the 
utility is running.

Configure the computer so the 
person has administrator permis-
sion.

Copy the Virtual Scope folder to a 
location elsewhere on the com-
puter with the appropriate permis-
sions and run it from there.

The Virtual Scope utility does not 
exit when selecting Exit in the 
File menu or the X in the 
upper-right corner and an error 
message is displayed.

The Virtual Scope does not have 
write permission to update the 
Scope_Config.xml file.

Make sure that the Virtual Scope 
is being run from a folder where it 
has write permission.

Select Quit in the File menu to 
force Virtual Scope to close.

The error message “Dot indexing 
is not supported for variables of 
this type.” is displayed when 
selecting SETUP.

There is an error in the scope con-
figuration.

Delete the Scope_Config.xml and 
node_configuration.mat files 
from the install folder then restart 
the scope.
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Table 5-2: Signal Troubleshooting

Symptom Problem Solution

The message “Warning: No data 
received from IP_address.” is dis-
played in the Information Panel.

Another device is accessing the 
HLC on TCP port 8000.

Determine the location of the 
other device and disconnect it.

Cannot connect to the specified IP 
address.

Verify all network connections 
(use the Windows Command 
Prompt to ping the IP address). 
Contact the IT department at the 
facility for additional network 
support.

Verify that the correct IP address 
is entered in the Setup Scope 
Data Collection dialog box.

Verify that the correct IP address 
is specified in the Node Control-
ler Configuration File.

The HLC is not responding. Verify that the correct IP address 
is specified for the HLC.

Verify that the HLC is running by 
connecting to it through the web 
interface.

The motor is not responding. Verify that the correct motor is 
specified in the Setup Scope 
Data Collection dialog box.

Verify that the correct path is 
specified in the Setup Scope 
Data Collection dialog box.

Use the host controller or the 
NCHost TCP Interface Utility to 
verify that the motor is running.

The information that is requested 
is not available.

Verify that the correct Vehicle ID 
is specified in the Setup Scope 
Data Collection dialog box.

Verify that the vehicle is moving 
over the specified motor.

The motor is not actively con-
trolling a vehicle.

Use the host controller or the 
NCHost TCP Interface Utility to 
move a vehicle onto the motor.
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The waveform is not being dis-
played.

Another device is accessing the 
HLC on TCP port 8000.

Determine the location of the 
other device and disconnect it.

There is no data to display. Command a vehicle onto the 
motor.

The signals are not selected in the 
Channel Controls.

Verify that the desired channels 
are On (selected).

The wrong motor, path, or vehicle 
is specified in the Setup Scope 
Data Collection dialog box.

Verify that the correct motor, 
path, and vehicle are specified.

The waveform is off the screen. Adjust the vertical Offset and 
Scale.

Set signal Coupling to AC if the 
signal has a large DC component.

Set the Y Axis Limits to Fixed 
and specify an appropriate range.

The waveform is indistinguish-
able.

The waveform scale is either too 
large or too small.

Adjust the vertical Scale.

The waveform is not centered on 
the display.

Adjust the vertical Offset.

The beginning or end of the 
waveform is not being displayed.

Adjust the horizontal High or 
Low limits.

The waveforms do not make 
sense.

The Data Stream Configuration 
File specifies the wrong motor 
type.

Make sure that the correct Motor 
Type and Runtime Version are 
specified.

The waveforms are not updating. The Trigger Level is not set cor-
rectly or the wrong parameter is 
being used for the trigger.

Make sure that the Trigger is cor-
rectly defined for the parameter 
being monitored and the correct 
parameter is being used for the 
trigger.

Data may be dropped if the motor 
is using RS-422 communication 
and is located far from the start of 
the path (ex. Motor ID #10).

Reference a motor that is closer to 
the beginning of the path.

Data may be dropped if the vehi-
cle status update rate is too fast.

Reduce the vehicle status update 
rate.

“Value must be numeric” error 
message is displayed when enter-
ing values using EU formatting.

Virtual Scope uses US decimal 
formatting.

Format numbers using 1000.0 for-
mat (omit any commas).

Table 5-2: Signal Troubleshooting (Continued)

Symptom Problem Solution
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Contact Rockwell Automation Technical Support

Before contacting Technical Support, have the following information ready.

1. The name, email address, and telephone number of the person to contact.

2. The facility address where the system is located and the project name.

3. The date, time, and a detailed description of the anomaly, including:

• The command the equipment was executing when the anomaly occurred.

• The effect on system performance (for example, stalled vehicles, overheating).

• How the system was operating before the anomaly occurred and for how long.

• Any recent changes to the system (physical reconfiguration, speed/acceleration 
changes, configuration file changes).

• Any corrective actions performed (for example, system reset, replaced parts, 
loaded software, power cycle). Describe the results of those actions.

• Any special system environmental conditions (for example, vacuum, high heat, 
high humidity).

• Any potential non-MagneMotion causes of the issue (for example, power out-
age, mechanical interference, host failure).

• Reproducibility of the anomaly.

4. The equipment type, part number, serial number, and location in the system (path, 
motor id).

5. Include the following files from the time of the anomaly.

• Node controller and high-level controller log files.

• Node Controller Configuration Files.

• Host controller command logs (if available).

• Any product-related faults and error messages observed through the system 
host, NCHost, the web interface, and so on.

6. Include any other information that can assist our specialist.

Contact your Motion Solution Consultant or Rockwell Automation TechConnect℠ (rock-
wellautomation.custhelp.com).

https://rockwellautomation.custhelp.com/
https://rockwellautomation.custhelp.com/
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Appendix

Overview

The following appendices are included to provide the user with one location for additional 
information that is related to the Virtual Scope utility.

Included in this appendix are:

• Communications protocol.

• Data Stream file types.

• File maintenance.

• Additional documentation.

• Transport system configuration limits.
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Communications Protocol

Communications Format

The high-level controller (HLC) supports communication with the host application that runs 
on a general-purpose computer via TCP/IP over Ethernet as defined in the OSI model. Each 
layer of network communication within the standard OSI (Open Systems Interconnect, 
ISO/IEC 7498-1) model is described here. Ethernet TCP/IP runs directly over the TCP and 
UDP layer 4 transport layers in the OSI model. The MagneMotion® implementation of 
TCP/IP only uses the TCP transport layer.

Ethernet TCP/IP

The standard OSI model for layers 1…4 are outlined here. The HLC application runs on top of 
the TCP transport layer. The standard 10/100/1000 Base-TX, half-duplex, or full-duplex 
twisted-pair Ethernet is used for all network communications.

Physical Layer

The electrical interface that is supported for communication between the HLC software that 
runs on the node controller hardware and the host controller is twisted-pair Ethernet. This 
interface is based on the IEEE 802.3 and IEEE 802.3u Ethernet and Fast Ethernet communica-
tion standards.

The interface uses IEEE 802.3 and IEEE 802.3u standard signal levels for 10/100/1000 
Base-TX. A standard Category 5 or better cable is used to connect the HLC directly to the host 
controller when a hub, switch, or router is not used for the connection.

Data Link Layer

The data link layer is standard 802.3/802.3u Ethernet packet framing. This framing uses 6 
byte destination and source MAC addresses, 2 byte protocol type, 1500 byte MTU (maximum 
transmission unit) of payload data, and 2 byte FCS (frame check sequence). 10 Mbps and 100 
Mbps signaling rates in full-duplex and half-duplex modes are supported. It is expected that 
any standard Ethernet device that uses a twisted-pair physical layer will have no problems 
interoperating with the HLC computer at the physical and data link layers.

Network Layer

The network layer communications for the HLC is Internet Protocol Version 4 (IPv4). For 
diagnostic purposes during initial setup and optional network layer health status checks, the 
HLC supports accepting Internet Control Message Protocol (ICMP) echo requests and sup-
ports responding to echo requests with ICMP echo responses. The HLC supports the addi-
tional ICMP messages that are required to support IPv4 fragmentation and redirection of 
network layer packets to the next hop IP router if customer provided networking equipment 
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requires the HLC to honor such IP fragmentation or packet routing redirection. It is expected 
that any standard modern IPv4 implementation will have no problems interoperating with the 
HLC computer.

The HLC does not support dynamic routing protocols and does not act as a router in the cus-
tomer network. The HLC drops any packets that it receives via some other peer on the net-
work that uses the HLC computer as its next hop IPv4 router.

The HLC supports configuration with a static IPv4 address, network mask, and gateway 
address of the next hop IP router.

The HLC supports IPv4 Address Resolution Protocol (ARP) to support the discovery of peer 
Ethernet data link layer MAC addresses.

Transport Layer

The HLC uses a Transmission Control Protocol (TCP) stream over the IPv4 network layer to 
support an end to end connection.

The HLC is the server and the host controller is the client for TCP endpoint communication 
roles. The HLC listens for incoming TCP connections from the host controller (general-pur-
pose computer) on the following ports:

• 799 for the Host Control connection.

• 800 for the Host Status connections.

• 801 for the System Monitoring connection.

• 8000 for the MagneMotion Virtual Scope connection.

When the HLC receives an invalid message on an established TCP connection (due to a fram-
ing error), the HLC software drops the connection.

The HLC throttles incoming TCP connections to ports 799 and 800 if a problem occurs in the 
host controller software that causes an excessive number of connections to be established. In 
extreme cases, the HLC is forced to drop the connection. In the event a connection is dropped, 
the HLC waits one second before allowing a new connection.

Host Control Connection

The HLC supports one Host Control TCP connection from the host controller at a time. If a 
new TCP connection is made to TCP port 799 when the HLC already has an established con-
nection, the established connection is dropped and the new connection is used. Even though 
TCP/IP supports a more or less arbitrary number of peers at the transport layer, for safety rea-
sons, the HLC supports only one Host Control TCP connection at a time.
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Host Status Connection

The HLC supports up to four Host Status TCP connections at a time. If a new TCP connection 
is made to port 800 when the HLC already has four established connections, the oldest con-
nection is dropped and the new connection is used.

NOTE: The Host Status connections can be used to monitor the status of the transport sys-
tem using the various status request commands. Any other commands are dropped.

System Monitoring Connection

The HLC supports one System Monitoring connection at a time. If a new TCP connection is 
made to port 801 when the HLC already has an established connection, the established con-
nection is dropped and the new connection is used.

NOTE: The System Monitoring connection can be used to monitor the status of transport 
system components using the various monitoring request commands. Any other 
commands are dropped.

Virtual Scope Connection

The HLC supports one Virtual Scope TCP connection at a time. If a new TCP connection is 
made to port 8000 when the HLC already has an established connection, the established con-
nection is dropped and the new connection is used.
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Data Stream Configuration Files

The name of the data_stream_config.xml file identifies its use as shown in Figure A-1 and 
Table A-1. Additional Data Stream Configuration files can be created for monitoring of cus-
tom data sets. Contact your Motion Solution Consultant or TechConnect℠ (rockwellautoma-
tion.custhelp.com) for more information.

Figure A-1: Data Stream Configuration File Naming Convention

Table A-1: Data Stream Configuration File Data Set Identification

Data Set ID Description

1 Standard Velocity

2 Filtered Velocity*

* Uses a Low Noise filter that the motor applies. This filtered value is the velocity value
that is returned to the host controller when using vehicle status commands.

Data Set ID

Motor Type
Motor Code Version

Optional Comment

ML_G4_v00.00.00_DataSet_50000 (xxx).xml

https://rockwellautomation.custhelp.com/
https://rockwellautomation.custhelp.com/
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File Maintenance

Backup Files

Making regular backups of all files that have been changed is recommended. Keep copies of 
all original and backup files at a remote location for safety.

Creating Backup Files

Backup files are not created automatically. It is the responsibility of the user to create backups 
of all files by copying them to a secure location.

Restoring from Backup Files

Damaged files can be restored by copying the backup files into the appropriate locations.
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Additional Documentation

Release Notes

The release notes that are supplied with MagneMotion software include special instructions, 
identification of software versions, identification of new features and enhancements, and a list 
of known issues. Reading this file is recommended before using the software.

Upgrade Procedure

The upgrade procedures that are supplied with MagneMotion software provide instructions 
for upgrading from one version of MagneMotion software to another. They also include the 
procedures for file and driver upgrades that are associated with the software.
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Transport System Limits

Table A-2: MagneMotion Transport System Limits

Path Node Controller System (HLC)

Motors 20/RS-422
30/Ethernet –† 3,840

Node Controllers – – 96

Nodes 2 –†

† When using RS-422 communication with the motors, limited by the number of RS-422 connections on the
node controller (NC LITE up to 4 connections, NC-12 up to 12 connections, NC-S up to 8 connections).
When using Ethernet communication with the motors, limited by the node controller configuration and pro-
cessor loading (NC LITE up to 5 nodes, NC-12 up to 16 nodes, NC-E up to 36 nodes, NC-S up to 16 nodes),
see the Node Controller Hardware User Manual, MMI-UM013.

320

Paths – –† 160

Stations – – 2048

Vehicles 50/RS-422*

300/Ethernet

* When using RS-422 communication with the motors, 50 vehicles maximum per path when all vehicles on the
path are commanded forward (downstream).
45 vehicles maximum per path when all vehicles on the path are commanded backwards (upstream).

384 5,120‡

‡ 6,000 vehicles maximum when using HLC Control Groups.

Table A-3: MagneMotion Transport System Motion Limits*

* The limits that are shown are at the typical payloads (contact your Motion Solution Consultant or TechCon-
nect℠ (rockwellautomation.custhelp.com) for payload guidance). Use of a smaller payload may permit higher
limits. Use of a larger payload may lower the limits.

Acceleration Velocity Thrust

MagneMover® LITE†

† The limits that are shown are for standard MagneMover LITE glide pucks. Using other pucks, or custom vehi-
cles, may permit different limits.

2.0 m/s2 [0.2 g] 2.0 m/s [4.5 mph] 10.0 N/cycle‡

‡ Thrust at 25% duty cycle, nominal Vehicle Gap is 1 mm for G3 and 1.5 mm for G4.2 magnet arrays.

QuickStick® 100 9.8 m/s2 [1.0 g] 2.5 m/s [5.6 mph] 16.3 N/cycle§

§ Thrust at 4.0 A stator current with a nominal Vehicle Gap of 3 mm with a standard magnet array.

QuickStick® HT with QSMC 60.0 m/s2 [6.1 g] 3.5 m/s [7.8 mph] 182.0 N/cycle**

** Thrust at 10.9 A stator current with a nominal Vehicle Gap of 12 mm with a high flux magnet array.

QuickStick® HT with QSHT 5700 Inverter 60.0 m/s2 [6.1 g] 5.0 m/s [11.2 mph] 182.0 N/cycle**

https://rockwellautomation.custhelp.com/
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf
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Glossary

Block:  See Motor Block.

Bogie:  A structure underneath a vehicle to which a magnet array is attached. The 
structure is then attached to the vehicle. For vehicles that travel over curves, 
the attachment is through a bearing that allows independent rotation.

Brick-wall Headway:  The space that is maintained between vehicles to make sure that a trailing 
vehicle is able to stop safely if the lead vehicle stops suddenly (“hits a brick 
wall”).

Byte:  An octet of data (8 bits).

Clearance Distance:  The distance from a node where the trailing edge of a vehicle is considered 
cleared from a node. See Entry Gate.

Component:  The main parts that form a MagneMotion® Transport System. Also called sys-
tem components, these include the High-Level Controller, Motors, Nodes, 
Node Controllers, Paths, and Vehicles.

Configuration File:  See Node Controller Configuration File.

Configurator:  The application that is used to define and edit the basic operating parameters of 
the transport system that are stored in the Node Controller Configuration File.

Control Path:  The path that is linked to a Peer Path to create a junction. Once linked, this 
path remains the Control Path for the life of the junction until the junction tran-
sitions to the unlinked state.

Controller:  A device that monitors and controls the operating conditions of the equipment 
being monitored. In a MagneMotion transport system, the types of controllers 
include the High-Level Controller, Node Controller, and Host Controller.

Couple:  The joining of a vehicle into a platoon, where one vehicle follows another 
vehicle at a defined distance.

Cycle Length:  The distance between the centerlines of two like poles on the magnet array.

Demo Script:  A text file that is used with the NCHost TCP Interface Utility for test or 
demonstration purposes to move vehicles on the transport system.

Design Specifications:  The unique parameters for a specific MagneMotion transport system.

Downstream:  The end of a motor or path as defined by the logical forward direction. Vehicles 
typically enter the motor or path on the Upstream end.
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Downstream Gap:  The physical distance from the end of the stator in one motor to the beginning 
of the stator in the next motor downstream on the same path. This distance 
includes the Motor Gap.

Drive:  The remote QSMC motor controller or the QSHT 5700 inverter for a QSHT 
motor.

Emergency Off:  A user-supplied device that disconnects AC power to the transport system.

Emergency Stop:  A user-supplied circuit with a locking button that anyone can press to stop 
motion in the transport system. It can be wired through the digital I/O on some 
Node Controllers.

EMO:  See Emergency Off.

Entry Gate:  The position on a path associated with a node where the leading edge of a vehi-
cle is considered cleared from the node. See Clearance Distance.

Entry Path:  A path whose downstream end is a member of a node. A vehicle that is moving 
downstream enters a node on an entry path.

Equivalent-Route Path:  A path in a set of Moving Path node member paths that offers a route to a 
destination that is reachable via any other path in the set.

E-stop:  See Emergency Stop.

Ethernet Chain:  Ethernet chains allow devices to be connected in series with standard Ethernet 
cable, without the need for additional network switches. A daisy chain device 
has two embedded Ethernet ports that function as an Ethernet switch and an 
interface to the local device. This embedded switch allows information to flow 
to the device, or flow through the ports to other devices in the chain.

Exit Path:  A path whose upstream end is a member of a node. A vehicle that is moving 
downstream exits a node on an exit path.

Fixed Path:  A path whose position is fixed in the track layout. See Moving Path.

Following Vehicle:  A vehicle following another vehicle in a platoon. This vehicle can be following 
either the lead vehicle or another following vehicle.

Forward Direction:  The default direction of motion, from Upstream to Downstream, on a Magne-
Motion transport system.

Glide Puck:  A preconfigured vehicle for use on MagneMover® LITE transport systems that 
uses low friction skids to slide on the integral rails.

Global Directives:  The Demo Script commands that define the general operating characteristics 
for all vehicles specified. See also Vehicle Directives.

Ground:  The reference point in an electrical circuit from which voltages are measured. 
This point is typically a common return path for electric current. See also PE.

Guideway:  A component of the Track System that consists of rails or other devices in con-
tact with the Vehicle, either through wheels or low friction runners on the vehi-
cle. The guideway maintains the proper relationship between the vehicles and 
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the motors. In the MagneMover LITE transport system, the guideway is the 
integral rails that are mounted on the motors.

Hall Effect Sensor:  A transducer that varies its output in response to changes in a magnetic field. 
Hall Effect Sensors (HES) are used by MagneMotion LSMs for vehicle posi-
tioning and speed detection.

Headway:  The space that is maintained before a vehicle to make sure that the vehicle is 
able to stop safely. See Brick-wall Headway.

High-Level Controller:  The application in a node controller that communicates with the host con-
troller. Only one node controller per HLC Control Group runs the high-level 
controller application. In a transport system with only one node controller, it 
runs both the node controller and high-level controller applications.

HLC:  See High-Level Controller.

HLC Control Group:  The portion of a multi-HLC LSM transport system under control of a specific 
HLC.

Host Application:  The software on the host controller that provides monitoring and control of the 
transport system.

Host Control Session:  A session between a host controller application (such as the NCHost TCP 
Interface Utility) and an HLC that allows control of all aspects of transport sys-
tem operation. The Host Control Session also allows active monitoring of 
transport system status.

Host Controller:  The user-supplied controller that provides control and sequencing for the oper-
ation of the transport system.

Host Status Session:  A session between a host controller application (such as the NCHost TCP 
Interface Utility) and an HLC that only provides active monitoring of transport 
system status.

ICT:  See Independent Cart Technology.

ID:  The software labels used to identify various components of the transport sys-
tem to make sure proper execution of commands involving vehicle position, 
vehicle destination, and transport system configuration. ID types include vehi-
cle and path.

Independent Cart Technology:  A programmable intelligent conveyor system that uses linear syn-
chronous motors for moving multiple independently controlled vehicles.

Interlock:  A user-supplied circuit that is used to stop motion in the transport system. It is 
wired through the digital I/O on the Node Controller.

Inverter:  The hardware that converts DC from the propulsion power bus to pulse-width 
modulated AC to energize the coils in a Motor Block and contains the Master 
and the Inverter for QSHT motors. See Drive.

Keep-out Area:  A unidirectional area of a Path. A vehicle that is moving in the specified direc-
tion of the area is not allowed to enter the area unless it has permission from 
the motors to either move past or stop within the area. Once a vehicle enters the 
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keep-out area in the specified direction, all other vehicles that are moving in 
the same direction must wait to enter the area until that vehicle exits.

Lead Vehicle:  The vehicle at the front of a platoon. This vehicle determines the destination, 
acceleration, and velocity of the platoon.

Linked Path Junction:  The junction in a Moving Path node between two member paths where 
motor-to-motor communication is being forwarded.

Logic Power:  The power that is used for the controllers and signals. See also, Propulsion 
Power.

LSB:  Least Significant Byte.

LSM:  Linear Synchronous Motor. See MagneMover LITE and QuickStick.

MagneMover LITE:  A MagneMotion linear synchronous motor with integrated guideways and 
vehicles that enable quick, efficient conveyance of small loads.

MagneMover LITE System:  A group of specific components that contribute to a Transport System. 
These components include MagneMover LITE motors, Node Controllers, 
Pucks, and other parts available from MagneMotion.

Magnet Array:  The magnets that are attached to the Vehicle. It is the motor secondary, moved 
by the primary in the motor.

Master (also Master Controller):  The supervisory controller for each motor, it communicates with 
the Slaves to direct Motor Block operation and read motor sensors. It commu-
nicates vehicle positions and other information to the Node Controller and 
upstream and downstream motors. It is internal to the motor assembly on Mag-
neMover LITE and QuickStick® motors. For QuickStick HT motors the master 
is in the Drive.

MM LITE™:  See MagneMover LITE.

MML™:  See MagneMover LITE.

Motion Controller:  The user-supplied controller for direct control of vehicles through the LSM 
Synchronization option. It can reside on the host controller.

Motor:  See LSM.

Motor Block:  A discrete motor primary section (coil or set of coils) in a motor that can be 
energized independently. This section can contain only one vehicle during 
transport system operation.

Motor Controller:  The hardware that converts DC from the propulsion power bus to AC to ener-
gize the coils in a Motor Block and contains the Master and the Inverter for 
QuickStick HT motors. See Drive.

Motor Gap:  The physical distance between two motors that are mounted end to end. This 
gap excludes the distance from the end of the stator to the end of the motor 
housing.

Moving Path:  A path that is moved to align with the end of another path. See Fixed Path.



Pitch

Virtual Scope User Manual 105
Rockwell Automation Publication MMI-UM011D-EN-P - January 2022

MSB:  Most Significant Byte.

NC:  See Node Controller.

Node:  A junction that is defined as the beginning, end, or intersection of Paths. The 
different node types define their use: Simple, Relay, Terminus, Merge, 
Diverge, and so on.

Node Controller:  The hardware and the application running on that hardware that coordinates 
vehicle motions along a path or paths of motors. The node controller is respon-
sible for the motors on all paths that begin at nodes that the node controller is 
responsible for.

There can be multiple node controllers in a transport system, each responsible 
for a subset of the nodes within the transport system.

Node Controller Configuration File:  The XML file unique to the transport system that defines the 
basic operating parameters of the transport system. A copy of the Node Con-
troller Configuration File is uploaded to each node controller in the transport 
system.

NRTL/ATL:  Nationally Recognized Test Lab/Accredited Test Lab.

OSHA recognizes NRTL organizations in accordance with 29 CFR 1910.7 to 
test and certify equipment or materials (products).

Accreditation bodies evaluate ATL organizations to ISO/IEC 17025 for testing 
and calibration laboratories.

OSSD:  Output Signal Switching Device. The interface of a sensor (such as a light cur-
tain) designed for reliably signaling a safety-related event. OSSD signals are 
outputs from the protective device to a safety relay.

Path:  A designation for one or more motors placed end to end, which defines a linear 
route for vehicle travel. A path begins at the Upstream end of the first motor in 
the series and ends at the Downstream end of the last motor in the series. All 
paths must begin at a Node and the beginning of a path is always the zero posi-
tion for determining positions along that path.

PE:  Protective Earth. A conductor that is provided for safety purposes (for exam-
ple, against the risk of electric shock) and which also provides a conductive 
path to earth. See also, Ground.

Peer Path:  The path that is linked to a Control Path to create a junction. Once linked, this 
path remains the Peer Path for the life of the junction until the junction transi-
tions to the unlinked state.

Pitch:  The distance between a point on one coil and the corresponding point on an 
adjacent coil in the same motor or an adjacent motor. Or, the distance between 
a point on one magnet and the corresponding point on an adjacent equivalent 
magnet in the same array.
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Platooning:  A group of vehicles that are moving together and following a lead vehicle. This 
group of vehicles is allowed to maintain a distance between each other while in 
motion that is less than the Brick-wall Headway.

Position:  A specific location on a Path, which is measured from the beginning of that 
path, which is used as a vehicle destination. Position zero on any path is 
defined as the leading edge of the first LSM in the path.

A vehicle at a specific position has its midpoint over that location on the path.

Power Supply:  The equipment that is used to convert facility AC power to the correct voltages 
for the transport system.

Propulsion Power:  The power that is used for vehicle motion. See also, Logic Power.

Protected Area:  The area around a node that is defined by the Entry Gates and Clearance Dis-
tances. This area is used to make sure that vehicles do not collide with other 
vehicles in the node or with the mechanism that is related to the node.

Puck:  A preconfigured vehicle for use on MagneMover LITE transport systems. The 
magnet array is mounted to the puck and interacts with the motors, which 
move each vehicle independently. See Glide Puck and Wheeled Puck. See also, 
Vehicle.

QS:  See QuickStick.

QuickStick:  A MagneMotion linear synchronous motor that enables quick, efficient con-
veyance of large loads on user-designed guideways and vehicles. QuickStick 
(QS) motors move loads up to 100 kg [220 lb] per vehicle. QuickStick High 
Thrust (QSHT) motors move loads up to 4,500 kg [9,900 lb] per vehicle.

QuickStick System:  A group of specific components that contribute to a Transport System. These 
components include QuickStick motors, Node Controllers, Motor Controllers 
(QSHT only), Magnet Arrays, and other parts available from MagneMotion.

Sensor Map:  A snapshot of the signal state of vehicle magnet array sensors that are collected 
from all blocks of a motor.

Signal:  Each motor contains sensors that detect the magnetic field from the magnet 
array. When the signal from the sensors is higher than a threshold, the signal 
bit for the associated sensor is set high, otherwise it is set low.

Single Vehicle Area:  A unidirectional area of a Path. Only one vehicle that is moving in the speci-
fied direction of the area is allowed to enter the area at a time. Other vehicles 
on the path that are moving in the same direction as the initial vehicle in the 
SVA must wait to enter this area until the previous vehicle exits. This queueing 
allows one vehicle to move backward and forward along a portion of a path 
without interfering with any other vehicles.

Slave (also Slave Controller):  The subordinate controllers for the motor, they communicate with 
the Master and operate the Inverters and position-sense hardware. They are 
internal to the motor assembly on MagneMover LITE and QuickStick motors. 
For QuickStick HT motors the slaves are in the Drive.
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Station:  A specific location on a Path, which is measured from the beginning of that 
path, and identified with a unique ID, used as a vehicle destination.

Stator:  The stationary part of the motor over which the magnet array moves.

Switch:  The mechanical guide for positioning a vehicle through guideway sections that 
merge or diverge.

SYNC IT™:  Provides direct control by a motion controller of up to three sync-zones 
(requires sync-enabled motors) where the host controller generates the vehicle 
motion profile.

Sync Zone:  An area where vehicle motion can be synchronized with other systems through 
direct control of the motor by the host controller.

System Component:  See Component.

Tandem Vehicle:  A vehicle that uses dual Bogies to provide enough thrust to carry larger loads.

Track System:  The components that physically support and move vehicles. For a QuickStick 
transport system, the track includes a Guideway, one or more QuickStick 
motors, mounting hardware, and a stand system. For a MagneMover LITE 
transport system, the track includes the MagneMover LITE motors and stands.

Transport System:  The components that collectively move user material. These components 
include the Motors, external Motor Controllers (QSHT only), Track System, 
Node Controllers, Vehicles, cables, and hardware.

Uncouple:  Remove a vehicle from a platoon.

Upstream:  The beginning of a motor or path as defined by the logical forward direction. 
The upstream ends of all paths are connected to node controllers. Vehicles typ-
ically exit the motor or path on the Downstream end.

V-Brace:  The mechanical fixture that is used to align and secure MagneMover LITE 
guide rail and motor sections.

Vehicle:  The independently controlled moving element in a MagneMotion transport 
system. The vehicle consists of a platform that carries the payload and a pas-
sive magnet array to provide the necessary propulsion and position sensing. All 
vehicles on paths in the transport system that are connected through nodes 
must be the same length.

The transport system constantly monitors and controls vehicle position and 
velocity for the entire time the vehicle is on the transport system. All vehicles 
are assigned a unique ID at startup and retain that ID until the transport system 
is restarted or the vehicle is removed or deleted.

Vehicle Directives:  The Demo Script commands that define the individual motion characteristics 
for a specific vehicle. See also Global Directives.

Vehicle Gap:  The distance between the bottom of the magnet array that is attached to a vehi-
cle and the top surface of a motor.
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Vehicle ID Master Database:  The HLC database for the assignment and tracking of Vehicle IDs in 
the transport system. When using HLC Control Groups, the Master HLC main-
tains this database.

Vehicle ID Slave Database:  The Slave HLC database for tracking of Vehicle IDs in the HLC Con-
trol Group managed by that Slave HLC and assigned by the Master HLC. This 
database is only used when using HLC Control Groups to subdivide a transport 
system.

Vehicle Master:  The motor controlling the vehicle.

Vehicle Signal:  A motor software flag for each vehicle that is used to indicate if the vehicle is 
detected on the transport system.

Vehicle Spacing:  The distance between two vehicles on the same path.

Wheeled Puck:  A preconfigured vehicle for use on MagneMover LITE transport systems that 
uses low friction wheels to ride on the integral rails.

Zero Point:  The position on the Upstream end of a Path that denotes the first part on which 
a Vehicle travels.
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Index

B
Backup, 98

C
Capture Data, 51
Channel Controls

description, 86
set, 42

Check Boxes, 69
Communication Cables, identification, 21
Computer Requirements, 25
Configuration File, see Node Controller Config-

uration File
Configurator, see MagneMotion Configurator
Connect to High-Level Controller, 35
Console Interface, description, 23
controller_image, see Node Controller Software

Image File
Customer Support, 114

D
Data Capture File

description, 24
review, 53
save, 51

Data Stream Configuration File
description, 24
load, 40
signal definition, 86

data_capture.csv, see Data Capture File
data_stream_config.xml, see Data Stream Con-

figuration File
Demonstration Script

overview, 24
use, 26

Dialog Boxes, 69

Disconnect from High-Level Controller, 33
Drop-Downs, 69

E
Edge Trigger, 44
Ethernet Motor Commissioning Tool, descrip-

tion, 23

G
Getting Started, 25
Graphical Buttons, 70
Grid Lines, 48

H
High-Level Controller

connect, 35, 37
disconnect, 33
identification, 21
IP address, 35, 37

HLC, see High-Level Controller
Horizontal Axis, 78
Horizontal Controls

description, 83
set, 43

Host Controller, identification, 21

I
Import Trace Data, 52
Installation Folder, 29

M
MagneMotion Configurator, description, 23
Magnet Array Type File, description, 23
Magnet Array, identification, 21
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magnet_array_type.xml, see Magnet Array Type
File

Manual
chapter descriptions, 16
conventions, 14
prerequisites, 13
related documents, 17

Measurement, 47
Menu

Advanced, 76
Channel Select, 85
Edge Trigger, 84
File, 73
Help, 76
Tools, 75
Trigger Channel, 84
Trigger Type, 84
Update Period, 83
View, 73
Zoom, 73

MICS File, description, 24
MICS_motor_data.xml, see MICS File
MMConfigTool.exe, see MagneMotion Configu-

rator
Motor

identification, 21
multiple motor monitoring, 37
single motor monitoring, 35

Motor ERF Image File, description, 23
Motor Type File, description, 23
motor_image.erf, see Motor ERF Image File
motor_type.xml, see Motor Type File
Multiple Motor Mode, 37

N
NC File Retrieval Tool, description, 23
NCHost TCP Interface Utility, description, 23
NCHost.exe, see NCHost TCP Interface Utility
Network, identification, 21
Node Controller

identification, 21
IP address, 25

Node Controller Configuration File
create, 25
description, 23

Node Controller Console Interface, see Console
Interface

Node Controller Software Image File, descrip-
tion, 23

Node Controller Web Interface, see Web Inter-
face

node_configuration.xml, see Node Controller
Configuration File

Noise Reduction Filter, 48
Notes, 15

P
PID Loop Tuning, 58
Power Cables, identification, 21
Power Supply, identification, 21

R
Restricted Parameters File, description, 24
restricted_parameters.xml, see Restricted Pa-

rameters File
Rockwell Automation Support, 114
Run Controls Section, 35, 37
Running the Virtual Scope Utility, 32

S
Safety Alert Types, 15
Scope Configuration File

description, 24
load, 40

Scope, see Virtual Scope Utility
scope_config.xml, see Scope Configuration File
Screen Data Files

description, 24
load, 52
review, 53
save, 51
screen_data.csv, 51
screen_data.vsdata, 51

screen_data.csv, see Screen Data Files
screen_data.vsdata, see Screen Data Files
Screenshot, 50
Setup, 35, 37
Single Motor Mode, 35
Software Types, 22
Stopping the Virtual Scope Utility, 33

T
TechConnect, 91
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Text and Display Fields, 70
Text Files

Data Capture File, 24
Demo Script, 24
Screen Data File, 24
Track file, 24

Track File, description, 24
Track Layout File, description, 24
track_file.mmtrk, see Track File
track_layout.ndx, see Track Layout File
Transport System

components, 21
MagneMover LITE, 19
QuickStick, 19
software, 22

Trigger Controls
description, 84
set, 44

Trigger, Edge, 44
Type Files

magnet array, 23
motor, 23

U
UI. see User Interface, 71
Update Period, 83
User Interface

overview, 71
starting, 32
stopping, 33

V
Vehicle, identification, 21
Vertical Axis, 78
Vertical Controls

description, 85
set, 45

Virtual Scope Utility
description, 20
running, 32
stopping, 33

W
Web Interface

description, 22
run, 37

X
X-Axis, 78
XML Files

Data Stream Configuration File, 24
magnet array type file, 23
MICS File, 24
motor type file, 23
Node Controller Configuration File, 23
restricted parameters file, 24
Scope Configuration File, 24
Screen Data File, 24
Track Layout file, 24

Y
Y-Axis, 78
Y-Axis Limit, 47

Z
Zoom

description, 73
set, 46
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Notes:
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